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1.1 Overview

1.2 Product
Description

Figure 1-1  Tekmar 3100

This section describes the 3100 Purge and Trap
Concentrator, defines its basic functions and system
configurations, provides technical specifications, and
outlines safety considerations for its use.

The 3100 is equipped with:

• Sample glassware for processing single samples.

• A front panel trap pressure gauge that shows the
current system pressure (in psi) for each mode.

• A front panel LCD screen that displays information
about the concentrator’s current operating step.

• ON/OFF switch on the back panel.

• A hand-held controller (purchased separately). The
controller consists of a four-line, 20-character wide,
LCD (liquid crystal display) and a 30- button
keypad. You communicate with the 3100
microprocessor by using the keypad and display
screen on the hand-held controller.

Hand-held
Control ler

Sample
Glassware

Top Panel

Vent
Purge
Drain

Trap
Pressure
Gauge

System
Pressure
Gauge

Front  Panel
Display

Right Front
Panel

The 3100 (Figure 1-1) is a purge and trap concentrator that
allows automatic processing of liquid and soil samples for
analysis by gas chromatography. The concentrator operates
and interfaces with the gas chromatograph (GC) under
microprocessor control.
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The 3100 purges volatile organic compounds from water or
soil onto a sorbent trap. The trap is then rapidly heated; the
analytes are swept with GC carrier gas onto the column for
separation and detection, as shown in Figure 1-2.

Figure 1-2  3100 Functions

1.3 Concentrator
Functions

The liquid sample to be
analyzed is loaded into the
front panel glassware on the
3100. A trap inside the
concentrator is packed with
an appropriate adsorbent
and maintained at ambient
temperature.

The liquid sample is
swept with purge gas to
release analytes from
the sample and deposit
them on the
concentrator trap.

��
��
��

Concentrator  trap

Purge gas

Sample 
 glassware 

Analytes are carried away
and deposited on the trap. 

�
�
�

Purge gas flows
through the glassware

�
�

to the
GC

Trap is

backflushed

with carrier gas

The concentrated analytes
on the trap are rapidly
heated. The heated trap is
then backflushed with gas to
deliver a tight band of
organic analytes to the gas
chromatograph.
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1.4 System

Configurations
The 3100 concentrator processes a single sample and
delivers the resulting analytes to a gas chromatograph.
You may also use the 3100 with other Tekmar-Dohrmann
accessories which can extend and enhance 3100 functions.
Please refer to the appropriate user manuals for further
information.

1.4.1 Tekmar 3100 with
Cryofocusing Module

For enhanced sensitivity and chromatographic resolution
when analyzing highly volatile compounds on a small bore
capillary column, Tekmar-Dohrmann recommends that you
use the Cryofocusing Module with the 3100.

• Highly volatile components desorbed from the internal
trap of the 3100 are refocused and condensed in the
trapping area of the Cryofocusing Module as carrier gas
goes through the module to the GC.

• The Cryofocusing Module freezes the condensed
components in a narrow, cryofocused band on the
column.

• The Cryofocusing Module is flash heated and flushed
with carrier gas to release the analytes on the GC
column.
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This section gives you specifications for the 3100. Please
refer to the appropriate user guide for autosampler
specifications.

Voltage: 100/115/230 volts (+/- 10%)
Frequency: 50/60 hertz (+1%)
Current: 5.0/4.0 amps
Power: 550 watts
Btu per hour: 1877

The 3100 operates at temperatures between 19°C (66°F) to
60°C (140°F) with humidity levels between 10% and 90%.

65 lbs. (29.48 kg.)

Height: 19" (48.3 cm)
Width: 9" (22.9 cm)
Depth: 18" (45.7 cm) deep

Ultra-high purity (99.999%) helium or nitrogen as purge
gas, supplied at 20 psig

The standard sampler is a 5 ml frit sparger, with all-glass
construction using a medium-porosity glass frit. Optional
glassware is: 25 ml frit sparger, 5 or 25 ml fritless sparger, 5
or 25 ml needle sparger and 25 ml disposable test tubes.

12" long; stainless steel tube; 0.010" wall thickness; 0.123"
+/- 0.002" OD (maximum OD of 0.125" is the USEPA
specified standard)

Controlled temperature range: from 5°C above ambient* to
420°C (-20°C to 420°C with optional TURBOCool);
average rise rate: 660°C/min. from 35°C to 225°C (The rise
rate is averaged over this temperature span; it is  invalid
outside this span.)

* temperature of the surrounding air

1.5 Specifications for the
3100

Utility Requirements:

Operating Environment:

Weight:

Dimensions:

Gas SupplyRequirements:

Sample Glassware:

Trap:

Trap Furnace:
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Variable; set at the factory to maintain a recommended back
pressure of  4 psi; flow rate: 35 ml/min.

• A 115 VAC motor-actuated, 6-port switching valve with
removable rotor; temperature controlled from ambient
to 300°C

• 12 VDC solenoid-actuated, 2 and 3-port sample, bypass,
high rate purge (HRP), drain and vent valves

• Flow Tuned Tubing (FTT)TM features constant uniform
internal diameters on all fittings, valves and tubing;
eliminates dead volume and maintains a constant linear
velocity during desorption to the gas chromatograph

• Transfer line, 72" total length - 60" outside of unit;
heated, variable:  ambient to 300°C

• Optional sample pocket and tube heaters; variable: from
ambient to 100°C

• 3100 concentrator: 0.1% after 1000 ng standard

There is no difference between carryover amounts using U-
shaped glassware versus needle sparger glassware (with or
without drain).

Calibration range: 0.5 ng to 2000 ng
System range: low ppt to 10 ppm

When using a Cryofocusing Module: Approximately 1 liter
to cool the cryofocus trap to -120°C. Then 1/4 liter per
minute once the cooldown temperature is reached (total
time for Desorb Preheat and Desorb modes.)

Removes moisture from the gas stream going to the GC;
operating temperature: 5°C above ambient to 400°C

Microprocessor - Motorola 68000, running at 12 MHz
CPU memory - 128K ROM; 64K RAM (expandable to
128K)

9600

Sample Path:

Valving:

Trap Pressure ControlTM:

Baud Rate:

Carryover Specifications:

Operating Range of
Concentration:

LN2 Consumption:

Moisture Control System:

Electronic Control:
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The 3100 accepts parameter values that you enter by way of
an RS232C serial interface. To enter the parameter values,
use one of the following:
• A hand-held controller connected directly to an I/O port
• A personal computer with optional TekLink software.

To use TekLink, you must have the following:
1. 80386 or greater computer running Microsoft®

WindowsTM version 3.1 or later
2. Any kind of DOS (version 5.0 or greater)
3. Hard drive with at least 2 MB (two megabytes) of

free space
4. 4 MB of RAM (8 MB recommended)
5. Disk drive that reads 3 1/2" 1.44MB diskettes
6. At least one free serial port for connection to the

3100

The 3100 uses a two-line, 20 character-wide LCD screen on
the front panel and a four-line, 20-character display on the
hand-held controller.

The 3100 has four expansion slots on the Mother Board for
accessory interfaces.

During operation, the 3100 sends and receives the
following signals:
• Begin/End Desorb output signal
• Start GC/MS and Data System output signal
• Desorb Ready output signal
• GC Ready/Continue input signal
• Purge Permission input signal
• Purge Ready output signal

The 3100 works with almost all commercially-available GC
instruments. It supplies or accepts GC and Data System
start and ready signals by way of a software-selectable GC
I/O board.

All commercially-available columns. Systems with
columns that have an I.D. of less than 0.53 mm may require
the Cryofocusing Module, depending on the systems'
configurations.

Up to 16 methods.

Up to 12 method changes in any sample order on a single
automatic cycle with a Tekmar-Dohrmann autosampler

I/O Signals:

GC Interface:

Column Capability:

Method Storage:

Expansion Capability:

Data Display:

Data Input:

Method Scheduling:
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Please read, understand, and follow all the precautions
described in this section before you set up, install, or
operate the Tekmar 3100 and any of its accessories. Tekmar
is not liable for any damage or injury resulting from failure
to follow the instructions in this manual or failure to
exercise appropriate care and caution in the installation,
operation, checking, and adjustment of the equipment
described in this User Manual.

1.6 Safety Precautions

1.6.1 Electrical

1.6.2 Temperature The 3100 and accessories contain heaters. The sample
heater in the 3100 can be as hot as 420°C when the 3100 is
in operation.

WARNING

• To  avoid electrical shock, turn off and unplug the unit
before servicing.

• Do not operate the unit without protective covers in
place.

• The three-wire power cord is a safety feature. To avoid
electrical shock, plug the power cord into a properly
grounded outlet. Do not use an extension cord; the
cord can overheat and cause a fire.

WARNING

Sections of the 3100 and accessories are heated during
operation.  If you touch a heater, you will be burned. Do not
touch the heaters.

CAUTION

Some Tekmar  accessories require the use of liquid CO2 or
LN2 . These chemicals produce very low  temperatures that
can damage human tissue. Avoid  touching the chemicals
or the surfaces that they cool.

CAUTION

Do not exceed  maximum pressure ratings for the 3100 or
accessories.

The 3100 and accessories (Cryofocusing Module, ALS
autosamplers, AQUATek 50, AQUATek 70, etc.) generate
hazardous voltage.
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The Cryofocusing Module uses liquid nitrogen coolant.1.6.3 Delivery Pressure

1.6.4 Miscellaneous

CAUTION

If coolant delivery pressure exceeds 75 psig, a relief valve on
the cryogenic valve assembly will vent the excess pressure.

WARNING

TURBOCool requires a SUPPLY of high pressure liquid C02.
Do not allow the SUPPLY pressure to exceed 1000 psi.

WARNING

To avoid any type of interference with the 3100 operation,
maintain at least two inches of unobstructed space around
the 3100. Move all other equipment outside the two-inch
perimeter. The 3100 requires a clear surface area of at least
20" (51cm) deep and 15" (38 cm) wide, with no shelves or
overhanging obstructions above. The surface
must be able to support at least 40 pounds.

CAUTION

Keep the 3100 away from corrosive gasses, liquids or solids.
Corrosive substances will damage outside surfaces and the
parts inside.

Operate TURBOCool in a well ventilated area to prevent
saturation of the ambient air with carbon dioxide.

CAUTION
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2.1 Overview This section describes:

• The prerequisites and site preparation for a 3100
installation.

• Unpacking and checking your 3100 shipment.

• The major components of the 3100.

Equipment installation and operation will be easier if you
use the illustrations to identify and locate the described
components on the 3100.

Please read the instructions in this section before you begin
to install the 3100. If you have any questions about site
requirements for installing and operating the 3100, please
call the Tekmar-Dohrmann Service Department at (800)
874-2004.

The 3100 operates at temperatures between 19°C to 60°C
with humidity levels between 10% and 90%.  Generally
speaking, an environment with temperature and humidity
that are reasonably constant and comfortable for an operator
is an environment in which the concentrator will perform
reliably.

2.2 Getting Ready for
Installation

2.2.1 Operating Environment

The 3100 requires a clear surface area at least 18" (46 cm)
deep and 15" (38 cm) wide, with no shelves or overhanging
obstructions above.  The surface must be able to support at
least 40 pounds.

CAUTION

Keep the concentrator away from corrosive substances -gas,
liquid, or solid - to avoid material and/or component damage.

To avoid any type of interference with 3100 operation,
maintain at least two inches of unobstructed space around
the unit.  Move all otherequipment outside the two-inch
perimeter.

WARNING
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2.2.3 Gas Supply Requirements Concentrator operation requires the availability of ultra-
high purity helium (as purge gas).  Check the following
items:

1. Helium purity must be 99.999%, 0.5% hydrocarbon
tested.

2. Gas pressure at the source must be high enough to:
• Allow at least 20 psi pressure drop at every flow or

pressure regulator.
• Travel the distance from the source to the

concentrator.
• Provide the required gas pressure at the

concentrator. Operation of the 3100 requires helium
at an incoming (supply) pressure of 20 to 60 psig.

3. Gas supply tubing diameter depends on the maximum
pressure drop allowable for your setup. If the helium
supply is close to the concentrator, you may use 1

8 "
diameter tubing. However, you may want to use larger
diameter supply lines, typically ¼",  to reduce pressure
drop under the following circumstances:
• The gas supply is a long way from the concentrator.
• A single source supplies several instruments.
• A single source will be subjected to high demand

for gas.
4. Gas supply tubing lengths must be adequate. Be

generous when cutting lengths of tubing for local
supply lines; a relatively long coil of tubing between the
supply and the 3100 allows you to move the instrument
(to reach rear cover panels, for example) without
disconnecting the plumbing.

5. Gas line fittings and regulators must be the correct size
and type.  Consult your local gas supplier for type and
size of cylinder valves; then select compatible pressure
regulators based on the required valves. Keep these
considerations in mind:

After selecting and clearing a location for the concentrator,
check the availability of the required grounded outlets.  The
3100 uses 115V/230V (± 10% ) power at 50/60 (±1%) Hz,
with one grounded, three-pronged receptacle for the main
power cord. Each additional accessory you plan to use may
also require one or more grounded outlets.

2.2.2 Power Requirements



Tekmar 3100 Purge and Trap Concentrator User Manual 2 -3

Getting Started 2

Please read the instructions in this section before you begin
to set up the 3100. If you have any questions about the set
up, please call the Tekmar-Dohrmann Service Department
at (800) 874-2004.

2.3 Unpacking the
Concentrator

1. Remove the 3100 kit box and the concentrator from the
shipping carton. Each concentrator is shipped with a kit
box. An optional installation kit with additional parts
needed to set up and install the 3100 is available from
Tekmar-Dohrmann (P/N 14-5092-100).

2. Compare the contents of the kit box and/or installation
kit against the packing list that accompanies your
shipment. Check for each listed item.  
• If an item is missing, call the Tekmar-Dohrmann

Customer Service Department toll-free at (800) 543-
4461; outside the US and Canada, call (513) 247-
7000.

• If any shipped item is damaged, immediately notify
the shipping carrier and the Tekmar-Dohrmann
Customer Service Department of its condition.

Failure to follow these instructions may void your warranty for
components damaged in shipment.

CAUTION

Always use instrument-grade Teflon®  tape to seal thread
connections. Do not use pipe dope or lower grades of
Teflon® tape;  volatile materials in the dope and/or low-
grade tape will contaminate the tubing.

CAUTION

• To reduce high source pressures to the pressure
required by the concentrator, use high-quality
pressure regulators with stainless steel diaphragms.
Tekmar-Dohrmann recommends using a single, two-
stage regulator, rather than two single-stage pressure
regulators to meet the concentrator’s pressure
specification.

• On/off valves, while not essential, are very useful
when mounted on the outlet fitting of a two-stage
regulator.

• Avoid pipe thread connections in your gas supply
lines.  If you must use them, seal them with
instrument-grade Teflon® tape.
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For the safety of everyone concerned, Tekmar-Dohrmann  will
not service returned instruments that are shipped with
needles or any other sharp objects installed on their exteriors;
Tekmar-Dohrmann  will promptly return these instruments to
customers.

This policy mainly applies to returned purge and trap
autosamplers, which are shipped with stainless steel needles
or glass dip tubes installed.

To receive prompt, reliable service, and reduce the risk of
injury, please remove all sharp objects from the exterior of any
Tekmar-Dohrrmann instrument before shipping.

WARNING

3. Examine the concentrator carefully.  If it is damaged,
notify the shipping carrier and Tekmar-Dohrmann
immediately. Do not continue installation until a
Tekmar-Dohrmann representative authorizes you to do
so.

4. Save all shipping materials until you verify that the
instrument operates correctly.

5. Do not return the concentrator unless authorized to do
so by a Tekmar-Dohrmann representative.
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The 3100 (Figure 1-1) consists of a concentrator with a
front-panel sample glassware assembly and an optional
hand-held controller.

2.4 Major Components

2.4.1 Hand-held Controller The hand-held controller is a four-line, 20-character wide,
LCD (liquid crystal display) and a keypad. The display
consists of data entry screens for programming and entering
data, menu and action screens for selecting options and
commands, and status screens for viewing during operation.

The front-panel display provides status information during
concentrator operation.
• The Trap Pressure gauge shows the current sample gas

pressure (in psig).
• The LCD screen displays information about the

concentrator’s current operating step. The first line
displays the step name, the number of the currently
active method (or operating sequence), and the number
for the position of the currently active sample. The
bottom line displays the current reading for the most
significant operating step parameter.

The front panel holds a single sample sparger assembly, as
illustrated in Figure 2-1.

�
�
�
� Drain Line

Purge Line

Front Panel

Frit

Figure 2-1 Sample Glassware Assembly

The 3100 can accommodate a 5 ml or 25 ml sample sparger.
The sampler mount is attached to the front panel; the
sample valve assembly and the glassware are shipped
separately for you to attach when you set up the 3100.

2.4.2 Front Panel Display

2.4.3 Front Panel Glassware
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Figure 2-2 shows a partial right side view of the Tekmar
3100 with the outer panels cut away to show the trap and
the electronic components.

Figure 2-2 Tekmar 3100 (Right Side) 
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The 3100’s right compartment holds the 12-inch long, 1/8"
diameter, sorbent-packed trap.The 3100 ships with a blank
#0 trap which needs to be replaced with the appropriate
packed trap. Analytes in the sample stream coming from
the sparger are adsorbed onto the packing material.

Concentrator operations are controlled by a group of logic
cards mounted in the rear half of the 3100 (see Figure 2-3).
The main logic card holding the controlling ROM (read-
only memory) chips is in the bottom slot. The board in the
top slot uses thermocouples to read temperatures. The other
five slots accommodate logic cards that make it possible for
the Tekmar 3100 to communicate with a personal computer
and to operate with one or more autosamplers or other
accessories.

2.4.4 Concentrator Trap

2.4.5 Electronic Components
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Figure 2-3 illustrates the concentrator’s rear panel, showing
the gas inlets for sample/purge and carrier gas.

~ O

Carrier

gas
inlet

Sample/

gas inlet

Transfer

line

Fan

Power
switch

Drain

GC I/O Port RS-232 port 

Purge

2.5 Gas Inlets and Outlets

Figure 2-3  Tekmar 3100 Rear Panel
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Sample gas (ultra-high purity helium) flows through the
sparger to carry organic analytes onto the trap. (Nitrogen
can be used as sample gas, but it may contain more
impurities.) The helium or nitrogen enters the back panel at
the opening labeled “Sample”.

Depending on the concentrator’s operating mode, sample
gas flows through the sample sparger (to carry analytes to
the trap), or it bypasses the sparger to circulate in a passive
circuit and flows out the front panel vent.

Tekmar-Dohrmann recommends a sample gas flow of 35
ml/min ± 5 ml for 11 minutes to achieve a 385 ml purge
volume.

Carrier gas is high purity helium (or nitrogen) used to
desorb volatile analytes off the internal trap and carry them
through the transfer line back to the GC. Carrier gas enters
the back panel at the opening labeled “Carrier”. Depending
on the concentrator’s current operating mode, carrier gas
flows through the trap and carries volatile analytes over to
the GC, or it makes a passive circuit through the
concentrator and returns, unchanged, to the GC through the
transfer line.

The valves visible from the top of the unit are:
• Two adjustable regulating valves near the back of the

3100. They control the sample pressure and sample
flow of gas entering the 3100 through the sample gas
inlet.

• The sample and bypass valves. Sample gas flows from
the flow controller to the sample valve. When the
sample valve is closed, sample gas flow is cut off. An
open sample valve directs flow to the bypass valve,
which routes it either to the sample sparger or to the
sample tee.

• The sample tee accepts flow from the sample sparger or
from the bypass valve and directs it to the six-port
valve.

• The six-port valve inside the valve oven has two
settings that control the direction of sample and carrier
gas flow through the concentrator.

• The trap pressure control (TPC) valve controls back
pressure on the concentrator trap.

2.6 3100 Valves and Lines

2.5.1 Sample/Purge Gas Inlet

2.5.2 Carrier Gas Inlet
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• The 3100 can work with the ALS 2016/2032 to process

up to 32 liquid and/or soil samples.

• The 3100 can work with the AQUATek 50 vial
autosampler to process up to 50 drinking and wastewater
samples.

• The 3100 can process up to 65 drinking and wastewater
samples with the 2016 and AQUATek 50 (up to 15 on the
2016 and up to 50 on the AQUATek 50).

• The 3100 can work with the AEROTrap 6016/6032 to
process up to 32 air samples.

• The 3100 can process up to 16 air samples (with the
AEROTrap 6016) or up to 16 liquid and soil samples
(with the AEROTrap 6032 and the ALS 2016).

• The 3100 can process up to 70 liquid samples with the
AQUATek 70.

For further instructions, see the manuals shipped with the
autosamplers.

If you plan to run samples that contain highly volatile
components on a small bore capillary column, Tekmar
recommends using a Cryofocusing Module (available as a
separate purchase) with the 3100. For more information, see
the manual shipped with the Cryofocusing Module.

TURBOCool is an optional accessory to the 3100. The
TURBOCool accessory keeps the trap at a uniform
temperature and permits purging onto a subambient* trap.
This minimizes breakthrough and improves resolution of the
lighter, early eluting gases in gas chromatography.

* temperature that is lower than the surrounding air

2.7 Autosamplers

2.8 Cryofocusing Module

2.9 TURBOCool

TekLink software makes it possible for you to use a
personal computer (PC) running Microsoft® WindowsTM to
monitor, schedule and control the operation of one, two,
three or four concentrators. Using TekLink, you can:

• define custom methods or operating sequences that
meet your analytical requirements.

• set up schedules for running certain methods at
specified positions on an autosampler.

• start, interrupt and/or reset a run in progress.

2.10 TekLink
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3.1 Overview

3.2 Making Pneumatic
Connections

The following sections tell you how to connect the 3100
and the GC pneumatically:

• To provide sample gas to the 3100, tee off the supply
line at point A (Figure 3-1). Follow the instructions in
the next section.

• To provide carrier gas flow and connect the 3100 to the
GC, cut the gas supply line at point B (Figure 3-1) to
divert carrier gas flow through the 3100 and back to the
GC via the 3100 transfer line.

This section provides instructions for the following:
• Connecting the Tekmar 3100 to the GC (electronically

and pneumatically)
• Installing accessories
• Leak checking the installation

The 3100 requires two independent gas flows:
• Carrier gas flows from the GC to the carrier gas inlet on

the 3100, through the 3100, and back to the GC by way
of a heated transfer line.

• Sample gas flows from the sample gas source to the
3100 sample inlet, through the sparger, over the trap,
and out the 3100 vent.

You may use a single gas supply as the source for both
sample and carrier gas; however, the flows must be
independent of each other. Figure 3-1 illustrates a GC
connected to a carrier gas supply. You can tap into the
carrier gas supply line to provide carrier and sample gas for
the 3100.

Figure 3-1  Gas Chromatograph Connections

Gas Chromatograph

Injection
Port

Detector

Carrier
Gas

A

B

GC Carrier
Gas Inlet
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Sample gas is usually supplied through a tee union from the
GC carrier gas supply tank.

1. If there is no tee union in the carrier gas supply line to
the GC, install one (as illustrated in Figure 3-2).

2. Run the sample gas line from the tee to the fitting
marked "Sample" on the concentrator’s rear panel.

3.2.1 Connecting the Sample Gas
Line

Note: If there is no hydrocarbon trap on the carrier gas supply,
install the trap provided in the 3100 kit box, as shown in
Figure 3-2.

Carrier
Gas

Carrier
Sample Tee

Hydrocarbon
Trap

Sample
Inlet

Gas ChromatographTekmar 3100

Injection
Port

Detector

Figure 3-2  Connecting to a Sample Gas Supply
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3.2.2 Connecting to the GC and

Carrier Gas Supply

When you make the connections illustrated in Figure 3-3,
the GC supplies and controls carrier gas flow to the 3100.
Using this configuration keeps the GC injection port free
for direct sample injections. You cannot use a Cryofocusing
Module with the configuration shown in Figure 3-3.

3.2.2.1 Using GC Regulated Carrier
Gas

When you connect the 3100 to the gas chromatograph, you
can:

• Make a direct column connection (using an optional
Cryofocusing Module, if desired), or

• Connect to the GC carrier gas inlet and leave the
injection port free for direct injections.

• Connect to the GC carrier gas inlet using a Low Volume
Insert in the GC injection port. Call Tekmar-Dohrmann
at 1-(800) 543-4461 for details.

Note: If you plan to use a Cryofocusing Module, you must make a
direct column connection to the GC.

Sample
Gas Inlet

Gas Chromatograph

Tekmar 3100 Injection
Port

Detector

Carrier
Gas

Carrier
Sample Tee

Hydrocarbon
Trap

����������������������������
����������������������������
����������������������������

Carrier
Gas Inlet

Heated
Transfer Line

Carrier
Inlet

1/16  Union

H

Figure 3-3  GC-Regulated Carrier Gas Connections
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3. Open the line at a point one or two inches from the
injector housing (point H in Figure 3-3). If a union
connects tubing from the carrier gas supply to the
stainless steel injector port inlet, disconnect the union.
If there is no union, cut the line.

4. Connect the line coming from the GC control
pneumatics to a 1/16" union.

5. Connect a piece of 1/16" nickel tubing to the union;
connect the other end to the union labeled "carrier" on
the back of the 3100.

6.  Connect the tubing to the injection port inlet (at point F
of Figure 3-4 on the following page) using a 1/16"
Swagelok union.

To make the connections:

1. Make sure the GC is not hot; allow it to cool to room
temperature.

2. Select an injection port. You may have to remove the
covers around the port to expose the stainless steel line
which supplies carrier gas to the port.

Note: You may need to secure the center of the union to the
column cage to relieve any stress caused by the weight of
the union.  If the injection port is split/splitless, you must cap
the split vent and septum purge. Some applications require
you to use the split. If this is the case, the split vent and
septum purge should remain open.

CAUTION
Some injection ports have multiple pieces of tubing
connecting to the injection port. Do not cut any lines unless
you are sure which is the carrier line.
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You must use an external pressure regulator (EPR) when the
back pressure in the GC's injection port is regulated on the
downstream side. The following systems require an EPR:

• Any Hewlett Packard GC that has a 0.2, 0.25, or 0.32
capillary column and a Cryofocusing Module installed.

• Any Varian GC that has a 1077 injector (split/spitless)
with a 0.2, 0.25, or 0.32 column and a Cryofocusing
Module installed.

Figure 3-4 shows the connections required to make a direct
column connection to the GC.

3.2.2.2 Making a Direct Column
Connection Using an
External Regulator
Assembly

Figure 3-4  Direct Column Connections to the GC
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To make a direct column connection:

1. Make sure the GC is not hot; allow it to cool down to
room temperature.

2. Since this configuration removes carrier gas flow from
the GC pneumatic control, you must install an external
pressure regulator (Tekmar-Dohrmann P/N 14-3938-
000, or equal) between the gas supply source and the
carrier gas inlet to the 3100.

• Disconnect the carrier gas line from the GC and run
it to the inlet of the external pressure regulator.

• Connect the outlet of the regulator to the carrier gas
inlet on the 3100 rear panel at point E (see Figure 3-
4).

3. Find an opening in the GC to route the transfer line into
the GC oven to make the connection to the column (i.e.
unused injection port or detector).

4. Using a zero dead volume union, connect the column to
the transfer line from the 3100 at point F (see Figure 3-
4).

Notes:

1. If you use the Tekmar 3100 with a Cryofocusing Module,
connect the transfer line to the Cryofocusing Module, not
directly to the GC.  Please refer to the Cryofocusing Module
Instruction Manual for installation instructions.

2. Be sure that the line heater assembly on the transfer line is
as close to the injection port as possible to minimize cold
spots.  As an alternative, the transfer line can pass through
the injection port with the union in the GC oven.
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1. Turn on the 3100 by pressing the power switch on the

rear panel.

2. Press ENTER to clear the Start-Up screen. The 3100
performs self tests and goes to Standby.

3. Make sure that Standby Flow is defaulted to ON.

4. Remove the top cover to expose the Sample Pressure,
Trap Pressure Control (TPC) and Sample Flow
controllers on the top left hand side. To avoid electrical
shock, do not touch any internal parts except the control
knobs.

5. Press and hold SHIFT while you press GO TO.

6. Press <B> Manual Operation.

7. Press <B> Feed Pressure. This closes the vent valve.
You will see a lashing P on the display while feed
pressure is on.

8. Set the sample gas pressure to 20 psi using the knob
marked "Sample Pressure". Read the pressure on the
front panel gauge.

The trap pressure control (TPC) valve is factory set at 4 psi.
However, you can change the setting. To do so:

1. Make sure Standby Flow is defaulted to ON.

2. If there is a flashing P, Feed Pressure is on. Turn it off
by pressing SHIFT-GOTO, then <B> (Manual
Operation), and then <B>, (Feed Pressure). The flashing
P should now be off.

3. Using the knob marked "Trap Pressure Control (TPC)",
set the system back pressure. Do not set the pressure of
the TPC valve equal to or higher than the GC column
head pressure.

3.4 Setting Trap Pressure
Control (TPC)

3.3 Setting Sample
Pressure
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1. Make sure Standby Flow is defaulted to ON.

2. Attach a flow meter to the vent fitting on the left front
panel of the 3100 to measure the flow rate of the sample
gas.

3. Set the sample gas flow to 35-40 ml/min using the knob
marked "Sample Flow".

Note: Anytime you adjust TPC or sample gas pressure, you must
recheck the sample gas flow; they are interdependent.

3.5 Setting Sample Gas
Flow

3.6 Installing the Drain
Tubing

To install a drain tube for the Tekmar 3100:

1. Attach a length of 1/8" I.D. plastic tubing to the fitting
marked "Drain" on the back of the concentrator.

2. Run the drain tube to a sink or waste bottle.

3.7 Making Electronic
Connections

3.7.1 Installing Logic Cards

If you are using an accessory like an autosampler or a
Cryofocusing Module, it must be connected electronically
to the 3100 by way of a cable. This cable extends from a
port on the accessory to a logic I/O card in the 3100. The
3100 must also be connected electronically to the GC.

You must install a logic I/O card in one of the 3100’s logic
card slots for each accessory that you connect to the 3100.

To access the logic card slots in the 3100:

1. Turn off and unplug the 3100.

2. Loosen the two 1/4 turn screws on the front of the
panel.

3. Slide the panel forward and then to the right to remove
it.

4. Slide the top panel forward. Then lift it up.

5. Remove the screw holding the top of the right side
panel.

6. Lift the right side panel away from the 3100 to expose
the logic card slots.
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To install a logic card:

1. Loosen the screw on one of the unused card slot covers.
Remove the cover.

2. Insert the logic card into the open card slot.  Push it in
until the back of the board is flush with the other card
slot covers and the card seats in the connector.

3. Tighten the screw on the board to secure it.

With each accessory, you received an interface cable as
well as a logic card. To connect an accessory to the 3100:

1. Insert one end of the cable into the port of the
appropriate logic card on the 3100.

2. Connect the other end of the cable to the logic card
connector in the accessory, following the installation
instructions for the accessory.

The 3100 comes with a GC interface card installed, as
shown in the view of the 3100 rear panel in Figure 3-5.

Instructions for connecting a 3100 to a specific model of
gas chromatograph accompany the interface cable required
for your specific 3100-to-GC setup.

3.7.2 Connecting to  Accessories
(Electronically)

3.7.3 Connecting to the GC
(Electronically)

25-pin 
GC inter-
face

RJ-11
connector

9-pin 
RS-232C
interface

Figure 3-5  GC Interface Card
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3.8 Leak Checking

Guidelines

To ensure accurate, reproducible results from analytical
runs with the 3100, check fittings (pneumatic connections)
for leaks. Follow these guidelines when you leak check
your 3100 installation:

• Leak check after you have completely assembled the
system and made all pneumatic connections.

• Use an electronic thermal conductivity detector (such as
a Tekmar-Dohrmann Gas Leak Detector, P/N 21-0052-
000) to check the fittings.

• Use helium (not nitrogen) as the pressurizing gas.
(Electronic leak detectors do not reliably detect
nitrogen.)

• If an electronic leak detector is not available, you may
use a 1:1 solution of isopropanol and water. Use the
solution sparingly to avoid contamination.

• Allow the 3100 to warm up for a least thirty minutes
before you leak check. The fittings need time to reach
operating temperature and expand; otherwise, they will
leak.

WARNING
To leak check, you must remove the 3100's panels. To avoid
electrical shock, do not touch any internal parts except the
control knobs. Before you leak check, remove jewelry; it
conducts electricity.
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To check for leaks in the sample gas flow lines:

1. Follow the instructions in Section 3.3, Setting Sample
Pressure.

2. Attach a flow meter to the vent fitting on the left front
panel of the 3100 to measure the flow rate of the sample
gas.

3. Use the knob marked "Sample Flow" to set the sample
gas flow to 35 - 40 ml/minute.

4. Put 5 ml of organic-free water in the purge vessel.

5. Do one of the following:

a. Put a 1/16" cap nut on the 3100 vent fitting on the
front panel. Tighten the fitting wrench-tight OR

b. If you have ROM (read-only memory) version 2.10
or greater, you can use the software's Leak Check
feature to cap the vent. This feature causes the
sample valve to open and the vent valve to close. To
start Leak Check, press SHIFT-GOTO, then the B
key. Next, choose option C. A flashing "L" on the
display indicates that Leak Check is on.

6. Time the bubbling in the purge vessel. If the bubbling
stops between three to 14 minutes, the system is leak
tight; no further leak checking is necessary.

3.8.1 Leak Checking

• Do not use any type of soap solution (for example,
Snoop or Detect) to check for leaks. If soap gets into
the lines, it will cause background and adsorption.

• If you tighten fittings before the 3100 has pressurized
and warmed to operating temperature (30 mins.), you
could damage the ferrules by overtightening the nuts.
You could also strip the threads on the nuts and not be
able to remove them.

• If you find a leak, finger-tighten the nut, then turn 1/4-
turn with a wrench.  Recheck. If it still leaks, look for
other possible causes; do not over-tighten. Leaks can
also be caused by a crack in the line or a damaged nut
or ferrule. Also, a part may be of incorrect size or
material. If a leak problem persists, call Tekmar-
Dohrmann Service.

CAUTION
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To diagnose a leak:

1. Make sure the leak is not at the capped vent. The
Swagelok nut may be worn.

2. If the bubbling stops before three minutes have elapsed,
it is likely that there is a leak upstream of the purge
vessel (before the gas flow reaches the purge vessel). If
a leak is indicated, leave the system in purge with the
vent capped. Capping the vent causes pressure to
increase, which exaggerates the leak and makes it easier
to find.

3. If the bubbling continues after 14 minutes, a leak exists
downstream of the purge vessel (after the gas flow
leaves the purge vessel).

4. Using an electronic leak detector, check the fittings at
the top and bottom of the trap.

5. Check the fittings inside the valve oven of the 3100.

6. Check these five fittings around the glassware on the
front of the 3100:

a. Purge line fitting (at glassware)

b. Purge bulkhead (at the 3100)

c. Sample glassware fitting

d. Sample needle nut

e. Sample valve (three-port)

7. Check the Swagelok fittings inside the 3100.

After you have installed the 3100 and made all pneumatic
connections, the GC column back pressure gauge should
show the same reading as before.

• If the gauge reading is higher that its pre-installtion
level, check the lines for clogs.

• If the gauge reading is lower than its pre-installation
level, there is a leak. Check fittings with a leak detector;
tighten as necessary.
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4.1 Overview An analytical run on the Tekmar 3100 consists of a

programmed sequence of steps, called a method.

This section performs the following functions:

· Describes the operating steps used by the 3100 in
various analytical configurations and defines the default
values assigned to parameters in each step.

· Tells you which parameters you can program to create
customized methods.

4.2 Steps in an Operating
Sequence

Depending on the system configuration and installed
accessories, the 3100 goes through a programmed sequence
of operating steps. Table 4-1 lists the operating steps in
order of their occurrence. If an operating step is active only
under certain conditions (with a specific system
configuration or when a specific accessory is installed), the
second column in the table defines the conditions. The third
column in the table describes each step.
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Table 4-1  Tekmar 3100 Operating Steps
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4.3 Operating

Cycle Time

If the time from GC Start to GC End (including time for the
GC to cool down) is longer than the uninterrupted 3100
cycle time from Desorb to Desorb, the 3100 waits in Desorb
Ready until it receives a GC READY signal from the GC.
To minimize the length of time in Desorb Ready (and
reduce cryogenic usage), a GC Synchronize step is added
between samples for all multiple sample runs, as illustrated
in Figure 4-2.

Figure 4-1  GC and 3100 Cycle Times

Operating cycle time is important for system configurations
in which a TurboCool accessory is installed. Figure 4-1
illustrates relative operating cycles for the 3100 and the GC.
Each unit has a fixed cycle time, or number of minutes
required to complete an operating sequence.

Purge
Desorb Ready

Desorb Purge
 Desorb Ready

Desorb

3000 Cycle

GC Cycle
GC Start GC End

 - from Desorb to Desorb

 Ready
Purge

Desorb Ready
Desorb Bake

GC Synchronize

GC Start GC End

Desorb Ready
Desorb

GC Cycle

Purge

Figure 4-2  Synchronizing 3100 and GC Cycle Times
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Purge and trap operations are controlled by valve
configurations that determine gas pressure and flow for
carrier gas and sample gas.  Figure 4-3 shows the drain
lines, vent lines, and flow paths for carrier gas and sample
gas in the 3100.

The flow controller and pressure regulator control the flow
rate and pressure of the gas coming into the 3100. Gas
flows to the normally closed sample valve. If Standby flow
is turned on through the software, gas flows through the
sample valve during Standby, Purge Ready, Purge, Desorb
Ready, Desorb with Drain and Bake. If Standby flow is
turned off, gas flows through the sample valve during
Purge, Dry Purge and Bake. Also, when you use Desorb
without the drain, the sample valve is closed.

 Figure 4-3  3100 Flow Paths

4.4.1 Valve Settings

4.4 Operating Step
Parameters

4.4.1.1 Sample Valve

4.4.1.2 Bypass Valve When the sample valve is open, sample gas flows to the
three-way bypass valve. During the Standby, Purge Ready,
Dry Purge, and Bake (with Bake Gas Bypass) steps, the
bypass valve directs flow from the sample valve to the
sample tee, bypassing the sample glassware. During the
Purge, Desorb Ready, Desorb Preheat, Desorb, Desorb with
Drain, and Bake steps, the bypass valve directs flow from
the sample valve to the sample glassware on the front panel
of the 3100.
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The drain valve opens to allow liquid to flow from the
sample glassware to exit at the 3100 drain at the rear of the
concentrator.

The high rate purge (HRP) valve is normally closed. It
works with the drain valve. When the HRP and drain valves
are open during the Desorb step (when autodrain is on),
incoming sample gas is split, allowing flow to pressurize
the sample glassware and force liquid up through the
needle, out of the glassware through the drain on the rear of
the 3100.

The vent valve opens to allow pass-through flow during the
Standby, Purge Ready, Purge, Dry Purge, Bake, and Bake
with Bake Gas Bypass steps. When it is open, gas flows
through the sample pathway and out the vent on the front of
the 3100.

The backflush valve opens to allow pass through flow
across the trap during Bake.

The six-port valve (located inside the valve oven) has two
positions that control the direction of sample and carrier gas
flow through the concentrator. The concentrator operates
with two separate gas flows:

• Sample gas enters through the sample gas inlet at the
back of the unit and exits through the front panel vent
valve.

• Carrier gas enters through the carrier gas inlet at the
back of the unit and proceeds through the transfer line
to the gas chromatograph.

4.4.1.3 Drain Valve

4.4.1.4 HRP Valve

4.4.1.5 Vent Valve

4.4.1.7 Six-Port Valve

4.4.1.6 Backflush Valve
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The Standby configuration for the six-port valve is in effect
during all operating steps except Desorb (with or without
drain). In Standby:

• Carrier gas enters the six-port valve and exits
immediately through the transfer line to the gas
chromatograph.

• Sample gas enters the six-port valve from the sample
tee and flows over to the trap; from the trap it returns to
the six-port valve and exits out the vent valve.

Figure 4-5 depicts the six-port valve Desorb
configuration.This configuration is in effect during Desorb.
Carrier gas enters the six-port valve and flows over to the
bottom-of-the-trap area, backflushes the trap, returns to the
six-port valve, and exits through the transfer line to the gas
chromatograph.

5

6

4

3

1

2

to vent valve

to BOT and trap

carrier gas

to transfer line

from MCS and
internal trap

from sample tee

Figure 4-5.  Six-port Valve Desorb Setting

2

3

4

5

6

1

to vent valve

carrier gas from GC

to transfer line to GC

from 

 internal trap

to MCS and

internal  trap

from 
sample tee

 Figure 4-4  Six-port Valve Standby Setting

The six-port valve controls the route traveled by the sample
and carrier gas during each step in the operating sequence.
Figure 4-4 shows the initial six-port valve setting, called
the Standby configuration.
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The trap pressure control (TPC) valve is a needle valve
located between the vent valve and the front panel vent
opening. The TPC valve regulates back pressure on the trap.
Increasing pressure on the trap shifts the partitioning of

volatile analytes between the vapor phase and stationary
phase, allowing the analytes to have increased interaction
with the adsorbent. They do not travel as far into the
adsorbent, and, as a result, are released in a tight band upon
desorption. This improves peak shape and sensitivity.

The TPC valve is not under program control; you adjust it
manually. At the factory, the TPC valve is set to maintain
the recommended back pressure of 4 psi. Do not set the
pressure of the TPC valve equal to or higher than the GC
column head pressure. As a rule, the difference between the
TPC valve and feed pressure settings should be greater than
10 psi. For example, if the feed pressure is 20 psi, set the
pressure of the TPC valve less than 10 psi. While TPC
valve pressure can be beneficial at the correct level, setting
it too high can cause carryover.

An operating step can define the temperature setpoint for
heating or cooling and the length of time during which the
temperature will be maintained at setpoint. Depending on
your system configuration and installed accessory options,
you can program methods that specify required time and
temperature values for heating and/or cooling the following
parts:

• Sample heater on the front panel (optional).

• Six-port valve and tee in the valve oven.

• Transfer line heater from the 3100 to the GC.

• Moisture Control System (MCS) just behind the trap.

• Adsorbent trap during Standby, Desorb, and Bake.

• Bottom-of trap (line from the six-port valve to the
bottom of the trap).

• Cryofocusing Module at the injection port of the GC (if
used).

• Valve and line temperatures of optional autosampler(s).

4.4.2 Time and Temperature
Parameters

4.4.1.8 Trap Pressure Control Valve
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4.5.2 GC Synchronize

Table 4-2   Valve Configuration during Standby and Purge Ready

Before beginning a run, the 3100 is in Standby. Standby is
active until heated (and/or cooled) parts reach their
setpoints.

4.5 Understanding
Operating Steps

Figure 4-6  Gas Flow during Standby and Purge Ready

4.5.1 Purge Ready On the first run in a schedule, this step pauses to wait for a
start signal. If the 3100 is operating with an autosampler,
the autosampler rotates through sam- ple positions until it
reaches the starting position specified in the current oper-
ating sequence. Figure 4-6 and Table 4-2 show valve
configurations during Standby and Purge Ready.

1 Only if Standby Flow is on.

If you have installed a TURBOCool accessory, a GC
Synchronize step replaces Purge Ready between runs on a
multiple sample sequence. During GC Synchronize, the
3100 waits before proceeding to the next step. The 3100
calculates the length of the delay (up to 1000 minutes),
based on the GC cycle time parameter. Valve settings
during this step do not change.

Valve Sample Bypass Vent HRP Drain 6-port Backflush
Designation:
Position: open1 on1 open1 closed closed Standby closed
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If your configuration includes an AQUATek 50 automatic
sampler, during the Sample Fill time specified for this step,
the sample volume is transfer-red into the sample glassware
on the 3100 or on the ALS autosampler. For more
information, refer to the AQUATek 50 User Manual.

If you have installed a TURBOCool accessory, this step
cools the TURBO-Cool trap to its low temperature setpoint
(TURBOCool Temp).

If you installed and turned on a sample heater, the 3100 can
operate with Prepurge and Preheat steps. During Prepurge,
the bypass valve allows  purge gas to flow through the
sample glassware for a programmed time (Prepurge Time)
before the sample is heated. The flow of gas blankets the
sample with inert gas to avoid heat-induced sample
oxidation.

During Preheat, the sample is heated to the programmed
sample temperature setpoint (Sample Temp) for a
programmed time (Preheat Time). This step should be just
long enough to heat the sample to temperature. It is best to
avoid long preheat times. There is no Purge flow during
Preheat.

During Purge, the sample is purged with sample gas for the
time specified in the Purge Time parameter. Table 4-3 and
Figure 4-7 show the change in valve configurations for
Prepurge and Purge.

4.5.4 TURBO Cooldown

4.5.3 Sample Fill

4.5.5 Prepurge and Preheat

4.5.6 Purge

Table 4-3  Valve Configuration during Purge

Gas enters the sample gas inlet, flows through the pressure
and flow regulators, through the sample and bypass valves,
to the sample glassware.

Valve Sample Bypass Vent HRP Drain 6-port Backflush
Designation:
Position: open off open closed closed Standby closed
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Analytes are released from the sample. They flow through
the sample line and the six-port valve. Then they are
adsorbed on the concentrator trap.

During Dry Purge, the bypass valve closes, as indicated in
Table 4-4.

Dry Purge sweeps dry gas through the concentrator trap for
a programmed time (Dry Purge Time), normally 4 - 6
minutes. If the trap is packed with a hydrophobic adsorbent
like Tenax, the flowing gas removes water. If the trap
contains silica gel or charcoal, this step does not remove
water.

This step cools the MCS (Moisture Control System) to its
moisture removal setpoint (MCS Des Temp) for the Desorb
step.

Figure 4-7  Valve Configuration during Prepurge and Purge

4.5.7 Dry Purge

Table 4-4  Valve Configuration during Dry Purge

4.5.8 MCS Cooldown

Valve Sample Bypass Vent HRP Drain 6-port Backflush
Designation:
Position: open on open closed closed Standby closed
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During Desorb Ready, valve configurations change, as
shown in Table 4-5.

The 3100 outputs a Desorb Ready signal to the GC and
waits for a GC Ready signal in return. There is no Purge gas
flow. Temperature setpoints are maintained, unless the MCS
and Cryofocusing Module are cooling to their setpoints
(MCS Des Temp and CryoFocus Temp).

The Cryofocusing Module cools desorbed analytes and
focuses them on the head of the column before they are
introduced into the GC. Every operating sequence does not
use a Cryofocusing Module; this step is not required unless
a Cryofocusing Module is installed. Setting the
CryoFocuser parameter to "off" eliminates the cryofocusing
steps from the operating sequence. The Cryofocusing
Module will go to the Cryo Standby temperature. Dur-ing
Cryofocusing Module Cooldown, the unit is cooled to its
setpoint (CryoFocus Temp).

During Desorb Preheat, the concentrator trap is heated to a
specified temperature (Desorb Preheat) in preparation for
analyte transfer from the trap to the GC. There is no flow
through the concentrator trap during Desorb Preheat.

4.5.9 Desorb Ready

Table 4-5  Valve Configuration during Desorb Ready

4.5.10 Cryofocusing  Module
Cooldown

4.5.11 Desorb Preheat

Valve Sample Bypass Vent HRP Drain 6-port Backflush
Designation:
Position: closed off closed closed closed Standby closed
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Gas enters the 3100 at the carrier inlet, flows through the
six-port valve, backflushes the concentrator trap through
the MCS (where the water is trapped), and flows back to
the six-port valve, where it exits through the transfer line to
the GC. As the gas backflushes the trap, it carries released
analytes over to the GC.

Table 4-6  Valve Configuration during Desorb

Figure 4-8   Valve Configuration during Desorb

Valve Sample Bypass Vent HRP Drain 6-port Backflush
Designation:
Position: closed off closed closed closed Desorb closed

4.5.12 Desorb During Desorb, the six-port valve rotates and the
concentrator trap heats to a temperature setpoint (Desorb
Temp) for the time specified in Desorb Time. Figure 4-8
and Table 4-7 show the valve configurations in the 3100
during Desorb.
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If the 3100 is set to drain during Desorb, the HRP, sample,
and drain valves are open, as shown in Table 4-7.

4.5.13 Desorb with Drain

Table 4-7  Valve Configuration during Desorb with Drain

This is a timed step (specified by the Inject Time parameter)
during which the Cryofocusing Module is heated to a
programmed setpoint (Cryo Inj Temp). Heat releases the
analytes that had been immobilized on the Cryofocusing
Module column.

Note: Bake and Cryofocusing  Inject begin at the same time.

Bake cleans out the sample pathway by heating the MCS
and the concentrator trap to their programmed bake out
setpoints (MCS Bake Temp and Trap Bake Temp) and
blowing clean gas through the 3100 for the length of time
specified in the Bake Time parameter.

During Bake with Bake Gas Bypass (BGB) off, gas follows
the Purge flow path through the concentrator and glassware
to sweep out all moisture and residual analytes. If the
autodrain is on (i.e., drinking water samples), BGB should
be off. This allows gas to dry out the glassware. If the
autodrain is off (i.e., soils and wastewater samples), BGB
should be on. With BGB on, there is no flow through the
sample glassware. This prevents additional analytes being
“purged” onto the trap during the Bake mode.

4.5.14 Cryofocusing  Inject

4.5.15 Bake

Valve Sample Bypass Vent HRP Drain 6-port Backflush
Designation:
Position: open off closed open open Desorb closed
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5.1 Installing TekLink This section offers information and instructions on system

requirements, making a backup copy of the program disk,
and installing TekLink onto your hard drive.

To install and use TekLink, you need an 80386 or higher
computer with Microsoft Windows 3.1 or greater installed.
Your system should have a hard drive that has at least two
megabytes (MB) of free space and a floppy disk drive that
reads 1.44MB (3 1/2”) diskettes.

Before you install TekLink onto your hard drive, make a
backup copy of the diskette(s) and use the backup for
installation. Write-protect your backup copy to protect it
from accidentally being copied over. Store the original in a
secure place.

Note: Microsoft Windows version 3.1 (or greater) or Windows 95
must be installed on your computer before you can install
TekLink.

1. Start Windows and insert your backup copy of TekLink
into the appropriate floppy drive.

2. To begin the TekLink installation:

Windows 3.x:

• Choose File > Run in Program Manager.

Windows 95:

• Choose Start > Run...

3. Type A:\SETUP or B:\SETUP (depending on the drive
you are using) in the Run dialog box and click OK.

4. Follow the screen prompts. The first screen that appears
is the installation welcome screen (see figure 3.1.3.1).

5.1.1 System Requirements

5.1.2 Making a Backup Copy of
the Installation Disk

5.1.3 To Install TekLink
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5. Click Next.

6. The next installation screen appears:

7. Select a destination location for TekLink. C:\TEK3100
is the default directory. You may Click Browse to select
another file path.

8. Click Next.

9. You will then be prompted to select a Program Folder
for TekLink. The default folder is TekLink 3100.

Figure 3.1.3.1 Installation Welcome Screen

Figure 3.1.3.2 Installation Choose Destination Location Screen

Figure 3.1.3.3 Installation Select Program Folder Screen
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10. Click Next.

11. The final TekLink installation screen appears to
confirm software installation:

12. Click Finish.

TekLink will be installed onto the drive and directory you
specified. When the program is successfully installed, the
TekLink icon (see figure 3.1.4) will appear in its own
program group in the Windows Program Manager
(Windows 3.x) or in Start > Programs > TekLink (Windows
95).

Windows 3.x:

• In Program Manager, double-click on the TekLink 3100
program folder and then double-click on the TekLink
3100 icon (see figure 3.1.4).

Windows 95:

• Choose Start > Programs > TekLink 3100. Select the
TekLink 3100 program file.

Figure 3.1.3.4 Installation Setup Complete Screen

5.1.4 To Start TekLink

Figure 3.1.4 TekLink 3100 Program Icon
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The 3100 sample concentrator processes liquid or soil
samples for analysis by gas chromatography and operate
automatically, under microprocessor control, to process a
single front-panel sample or multiple samples loaded from
an autosampler. When programmed with custom methods,
this system can operate at different time and temperature
parameters and run different analytical sequences on
specified samples.

You can program custom operating sequences for up to
four concentrators by using a personal computer running
TekLink. TekLink makes it possible for you to use a
personal computer running Microsoft Windows to monitor,
schedule, and control the operation of one, two, three, or
four concentrators.

Before you begin setting up methods and running samples,
please familiarize yourself with the TekLink software as
described in this section.  TekLink must recognize and be
configured correctly with the concentrator/autosampler in
order to run properly.

5.2 Configuring the
Concentrator with
TekLink

5.2.1 Flash Upgrading the 3100
ROM

Tekmar-Dohrmann is committed to continuous product
enhancement.  The 3100 memory board ROM is flash
upgradable and can be upgraded easily by running the Flash
Upgrade program that is included with TekLink.

If you ever need to flash upgrade the 3100 memory board
ROM, please follow the instructions in section 3.2.1.1
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 5.2.1.1 Performing the Flash

Upgrade
1. Open the Flash program:

Windows 3.x:

• In Program Manager, double-click on the TekLink
3100 program folder and then double-click on the
Flash program icon (see figure 3.2.1.1a).

Windows 95:

• Choose Start > Programs > TekLink 3100. Select
the Flash program file.

2. Click on File and select Configure Ports.

Figure 3.2.1.1a TekLink 3100 Flash Program Icon

3. Enter the Com Port number the 3100 unit is connected
to.

4. Click OK.

Figure 3.2.1.1b TekLink 3100 Flash Configure Ports

Figure 3.2.1.1c TekLink 3100 Flash Com Port Setup
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6. Select the ROM Image File furnished to you by
Tekmar-Dohrmann. The file will have the version name
followed by the .bin extension.

5. Select File > Send Flash Image to Instrument.

7. Click OK.

8. You will see the Flash Burning Process in this window.
There are four indicators depicting the burning
progress:

a) Stage reflects the current state for each sector

b) Current Sector is a progress indicator

c) Error Count indicates the number of errors
encountered while trying to communicate with the
3100. After 3 errors, the Flash program will abort.

d) Verify Errors indicates the number of errors
encountered while trying to verify a sector on the
3100. After 3 errors, the Flash program will abort.

Figure 3.2.1.1d Send Flash Image to Instrument

Figure 3.2.1.1e Select File to Send

Figure 3.2.1.1f Flash Burning Process Window
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9. If the Flash programs aborts, one of three messages will

appear:

a) Connect Error

b) Lost Communication with Instrument

c) Can't Program Current Sector

Check the TekLink port configuration to verify the
correct com port setup. If you continue to encounter
errors, please call Tekmar-Dohrmann's Technical
Support Department. Inside the US and Canada: (800)
874-2004; outside the US and Canada: (513) 247-7000.

10. When Flash programming is successful, a status
window will appear

11. If Flash programming is complete, with no errors, exit
out of the Flash program, power down the 3100, then
power up the 3100. Your 3100 should now be updated
with the new ROM version.

12. To verify the programming of your ROM upgrade,
launch TekLink 3100 and click on the Help menu.
Select About TekLink. Your new ROM version, listed
after "3100 Firmware Version", should correspond with
the new ROM version programmed.
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When you first run TekLink, the TekLink Control Screen
appears.  The Control Screen serves as the primary
interface between the computer and the concentrator’s
configuration, instrument, setup, status, and operation
capabilities.

5.2.2 TekLink Control Screen

Figure 3.2.2 TekLink Control Screen

 Unit Control Menu
Displays Installed
Concentrator(s)
Configure Ports
Exit TekLink

 Instrument Menu
Instrument Control Operations:

Step, Start, Auto, Hold, Step
Standby, Step to Bake, and
Reset Instrument
View Temperature Zone
Status
Edit Method
Edit Schedule

 Setup Menu
Abort Schedule/Sample
Prime Internal Standard
Prime H2O Lines
Configure Instrument

 Control Buttons
Easy Access to Frequently-
used System Operations:

Step
Start
Auto
Hold
Drain

 Operation Status Window
Displays:

Current Operating Mode
Sample Vial Position on
Active Concentrator
Current Method Number
Mode Status (Auto or Hold)

 Instrument Status Window
Displays:

The Status of the Active
Concentrator(s)

 Help Menu
Index of Help Topics
Search for Help On
Using Help
About TekLink

Note: The Drain control button is only active when an AQUATek
70 method is running.
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TekLink must be configured to identify each connected
concentrator with its appropriate COM (communication)
port and must also designate a single concentrator as active
(see section 3.2.4) before further analysis settings can be
made.

5.2.3 Configuring COM Ports

1. From the Control Screen, choose Unit Control >
Configure Ports.

2. Type the name of the concentrator you are installing in
the Unit Name field (this can be any name).

3. Type the number (1-4) of the COM port that the
concentrator is connected to in the Com Port field.

4. Repeat steps 2-3 for each additional concentrator that is
connected to your PC.

5. Click OK to return to the Control Screen.

Note: If one of the COM ports is not responding or is unavailable,
TekLink displays an RS232 Error Message Screen (see
section 3.2.3.2).

Figure 3.2.3.1 COM Port Setup Screen

5.2.3.1 To Link Each Concentrator
With a COM Port



5 -10  Tekmar  3100 Purge and Trap Concentrator User  Manua l

Using TekLink  to Process Samples5

1. Click OK to close the RS232 Error screen.

2. Make sure all COM port and instrument connections
are secure.

3. Check the COM port number of your computer.

4. Repeat steps 1-5 in section 3.2.3.1. If the error message
appears again, please call Tekmar-Dohrmann Technical
Support at (800) 874-2004 for further assistance.

Note: A possible error may occur if the flash.exe program (or any
other program that may be using the same com port) is
running while configuring the com ports in TekLink. If this
occurs, close the conflicting program and continue with
setup.

5.2.3.2 To Correct the RS232 Error
Message During COM Port
Setup

Figure 3.2.3.2 RS232 Error Screen
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5.2.4 Designating an Active

Concentrator
After you have assigned a name and have configured each
connected concentrator to a COM port on your PC, you
must specify one of them as the active unit.

Note: You must specify an active unit in order to send, receive,
and/or schedule methods. However, you can edit methods
without tying them to a selected active unit.

5.2.4.1 To Designate an Active
Concentrator

The top portion of the Unit Control menu lists each
concentrator that is connected to the PC and configured in
TekLink.

2. Click on the name of the concentrator you want to run.

3. After you select the active unit, click outside of the
TekLink screen to close the Unit Control menu.

4. To verify the name and status of the designated active
unit, observe the Instrument Status window of the
Control Screen (see figure 3.2.4.1).

(A)The name of the selected unit appears in the Control
Screen title bar.

(B) A check mark appears next to the selected name in
the Unit Control menu.

(C) The Instrument Status window displays status
information for the active concentrator.

Figure 3.2.4.1 Unit Control Menu Displaying the Active Concentrator

1. From the Control Screen, select the Unit Control menu.

 (A)
The unit name appears in the
Control Screen title bar.

 (B)
A check mark appears next to
the name of the active
concentrator in the Unit Control
menu.

 (C)
The Instrument Status window
displays the status information
of the installed concentrators.
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5.2.5 Specifying Concentrator

Configurations
TekLink allows you to specify the instrument configuration
of any active concentrator.

To access the Instrument Configurations screen:

1. From the Screen, select Setup > Configure Instrument.

5.2.5.1 All A/C Outputs

2. Configure the concentrator by selecting options specific
to your system configuration.

3. Click OK to return to the Control Screen.

Use this option to specify whether the A/C Outputs are
controlled or off.

5.2.5.2 Standby Flow

5.2.5.3 Trap Region Type

The Standby Flow option indicates whether or not the
sample pathway is swept with gas during the Standby step.

The Trap Region option has three valid values:

1) Ambient: the concentrator uses the standard internal
trap at ambient temperature.

2) TurboCool: the concentrator operates at cryogenic
temperatures when the TurboCool unit (optional) is
installed.

3) Cryo: the concentrator operates at cryogenic
temperatures when the Cryofocusing Module (optional)
is installed.

Figure 3.2.5 Configure Instrument Screen
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5.2.5.10 Feed Pressurize Mode

5.2.5.9 Leak Check Mode

5.2.5.8 Manual Drain Mode

5.2.5.7 Self-Test Time

5.2.5.6 User GC Type

5.2.5.5 GC Type

The vent allows sample gas to exit the sample pathway
through a front panel vent.  When it is closed, pressure
builds up in the sample pathway.  This is used to set the
feed pressure (it eliminates Trap Pressure Control [TPC]
effects).

You can configure the concentrator for either a Standard or
User type GC Port. The GC type classification is based on
the input-output characteristics of the GC as it interacts
with the concentrator.

If you have ordered an interface cable, the User GC Type is
provided with the cable. If you have not ordered a cable,
you must know the characteristics of the input and output
signals traveling to and from the GC to determine the GC
User Type.

The Self-Test Time option allows you to specify a Self-Test
Time other than the default.

The drain valve allows the sample glassware to be emptied.
When it is open, liquid and gas can be forced out of the
sample glassware into the drain system and out the back
panel drain.

The Leak Check Mode option is only accessible during
Purge mode.

5.2.5.4 GC Handshaking The GC Handshaking option specifies GC handshaking
characteristics.

A) On normally operates the GC’s port.

B) Off operates the GC with no input or output signals
between the concentrator and the GC.
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After you have installed and configured the concentrator,
you can create customized methods (operating sequences)
for sample processing that meet your analytical
requirements.

After you have connected the required concentrator(s) and
configured your PC’s COM ports to recognize the
connected units, you can use the Method Editor to review
and edit methods.

5.3 Using Methods

To access the Method Editor screen:

1. From the Control Screen, select Instrument > Edit
Method.

5.3.1 Understanding the Method
Editor Screen

Figure 3.3.1 Method Editor Screen

 (A)
Method Editor File and
Communication menus

 (D)
Notes Text Box

 (E)
Min/Max Display Field

 (B)
Current method filename
displayed in the TekLink title
bar

 (C)
Method Parameter Values
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5.3.1.1 Default 3100 Method

Parameter Values
At first power up, the concentrator is scheduled to run
3100.mt3 which is the 3100 default front panel method.
The concentrator automatically performs self tests and
remains in Standby until all heaters and coolers have
reached their default temperature setpoints. When
temperature setpoints have been reached, the concentrator
goes into Purge Ready mode. At this point, you can either
press the Start control button to begin running 3100.mt3
with its default parameters or create, change, or select
another method schedule.

The default 3100 method file, 3100.mt3, is the default
method specifically configured for the 3100 and 3100.

Note: The 3100 method parameter defaults are guidelines. You
may need to edit certain values depending on your analysis
requirements.
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Method Parameter Value

Line Temp _______________________________________ 150ºC
Valve Temp ______________________________________ 150ºC
Mount Temp_______________________________________ 40ºC
MCS Line Temp ____________________________________ 40ºC
Purge Ready Temp _________________________________ 30ºC
Purge Temp ________________________________________ 0ºC
Turbo Cool Temp ___________________________________-20ºC
Sample Heater ______________________________________ Off
PrePurge Time ________________________________ 3 Minutes
Sample Preheat Time ___________________________ 5 Minutes
Sample Preheat Temp_______________________________ 40ºC
Purge Time __________________________________ 11 Minutes
DryPurge Time ________________________________ 0 Minutes
GC Start Option ____________________________ Start of Desorb
GC Cycle Time ________________________________ 0 Minutes
Cryo Focuser ________________________________________ Off
Desorb Preheat Temp ______________________________ 245ºC
Desorb Time __________________________________ 4 Minutes
Desorb Temp _____________________________________ 250ºC
Sample Drain _______________________________________ Off
Bake Time ___________________________________ 10 Minutes
Bake Temp ______________________________________ 280ºC
Bake Gas Bypass ____________________________________ On
Bake Gas Bypass Delay Time ____________________ 2 Minutes
MCS Bake Temp __________________________________ 310ºC

Table 3.3.1.1  Default Method Parameter Values for 3100.mt3
(3100 Front Panel Sampling)
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To load a method from the disk:

1. From the Method Editor screen, select File > Load
Method From Disk.

Figure 3.3.2.1 Select Method to Load Screen

2. Select the method file you want to load.

3. Click OK to return to the Method Editor screen. All
parameters will reflect the values of the loaded method.

The File menu (see figure 3.3.2) of the Method Editor
screen contains options for loading, saving, printing, and
deleting method files.

5.3.2. Method Editor File Menu

Figure 3.3.2 Method Editor File Menu

5.3.2.1 Load Method From Disk TekLink contains one default method file for the 3100.
Select one to view and edit. All method filenames end with
.mt3. Please review table 3.3.1.1 for default parameter
values.

Note: You cannot load method files from previous versions of
TekLink.
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5.3.2.2 Save Method to Disk Select File > Save Method to Disk to save the current

method file.

5.3.2.3 Save Method As... Select File > Save Method As... to save the current method
configuration under a new filename.

5.3.2.4 Print Method From Disk Select File > Print Method From Disk to print out the
parameter listing of a method file.

5.3.2.5 Delete Method From Disk Select File > Delete Method From Disk to permanently
remove a saved method file from your hard drive.

5.3.2.6 Exit Method Editor Select File > Exit Method Editor to exit out of the Method
Editor screen and return to the Control screen.
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Note: If the value you enter in the Method Editor is greater than
the maximum or smaller than the minimum values shown in
the Min/Max readout, TekLink displays an error message.

To clear the error message:

1. Click OK. The parameter value defaults to its previous
entry.

2. Enter a parameter value that is within the acceptable
min/max range.

 Figure 3.3.5.1 Method Parameter Value Out of Range Error Screen

The Notes text box (see ‘D’ in figure 3.3.1) permits you to
store up to 200 characters of text. TekLink stores the Notes
with the Method File when saved.

5.3.4 Notes Text Box

The Min/Max field (see ‘E’ in figure 3.3.1) displays the
minimum and maximum setting for each parameter value
when the cursor is placed within a parameter field.

5.3.5 Min/Max Field

5.3.5.1 Method Parameter Value
Out of Range Error

Three columns (see ‘C’ in figure 3.3.1) display values that
define time, temperature, and other operational parameters
for the current method. If a parameter and its value are
grayed out (or uneditable), then the accessory required is
not installed on your system. Please refer to the
concentrator user manual for further descriptions and
explanations of specific method parameters.

Note: If you have system accessories (e.g., Cryo Focuser,
20XX, AQUATek 50, or AQUATek 70) connected to your
concentrator, be sure to turn them On in the Method
Editor.

5.3.3 Method Parameter Values
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5.4 Defining a Method

Schedule
After you create customized methods, you can define a
method schedule that specifies samples, operating
sequences, and the order in which they will run.

5.4.1 Understanding the Schedule
Control Screen

To access the Schedule Control screen, select Instrument >
Edit Schedule from the Control Screen.

 Figure 3.4.1 Schedule Control Screen

The Schedule Control screen has four columns and 12 rows
for creating up to 12 method schedules.

5.4.1.1 Start and Stop Fields Enter the vial position number of the first sample in the
Start field and the vial position number of the last sample
in the Stop field to be run according to the specified
method. (The default sample start and stop positions are
both 0, the number assigned to the 3100 front-panel sample
on the concentrator unit.)

5.4.1.2 Method Display Field and
Method Selection Button

Click the Method selection button to select the filename of
the method you want to schedule. The filename of the
method you select appears in the method display field.
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5.4.1.3 RPS (Runs Per Sample)

Field
Enter the number of times each sample will be run.

5.4.1.4 Min/Max Field The Min/Max parameter status field at the bottom of the
Schedule Control screen displays the minimum and
maximum autosampler vial positions for the selected
method.

5.4.1.10 OK Schedule Button

5.4.1.11 Schedule Control Help
Button

The Send button sends the currently displayed schedule to
the active concentrator.

The OK button exits the Schedule Control screen and
returns to the Control Screen.

Note: You will not be prompted to save the current schedule if it
has changed or if you have not already saved it.

The Help button accesses online help information about the
Schedule Control screen.

5.4.1.9 Send Schedule Button

5.4.1.5 Load Schedule Button

5.4.1.6 Save Schedule Button

5.4.1.7 Print Schedule Button

5.4.1.8 Delete Schedule Line
Button

Press the Load button in the Schedule Control window to
open up a saved schedule file. The file extension for all
saved schedules is “.sch”.

Press the Save button in the Schedule Control window to
save the current schedule setup information to disk. The file
extension for all saved schedules is “.sch”.

Press the Print button in the Schedule Control window to
send the current schedule information to the default printer.

Press the Del Line button in the Schedule Control window
to delete the line in the current schedule. Make sure that
you place the cursor somewhere in the line to be deleted.
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You can use the Schedule Control screen to set up a method
schedule, or processing timetable, for running samples.
When you use the concentrator without an autosampler, you
specify the number and sequence of methods to be run on a
single sample.

When you use the concentrator with one or more
autosamplers, you set up a method schedule that defines:

• The method(s) to be run.

• Start and stop positions for each method.

• A sequential order for each sample to be run.

• The number of runs per sample.

You must use the Schedule Control screen to set up a
schedule, even if you are running a front-panel sample
position with the concentrator.

You can enter any desired method schedule and send it to
the selected concentrator within the Schedule Control
screen. Use the worksheet included in your concentrator
user manual to develop a method schedule.

5.4.2 Scheduling Runs
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5.4.2.1 Entering a Method Schedule 1. Click the Method button.

2. Select the method file of the method you want to run.

3. Click OK to return to the Schedule Control screen.

Note: If the method file you loaded is incorrect, click the Method
button again in the Schedule Control screen and select the
correct file.

4. Position the cursor on the Start field.

5. Type the position number of the first sample vial to be
run according to its method.

6. Position the cursor on the Stop field.

7. Type the position number of the last sample vial to be
run according to its method.

Note: If you enter an out-of-range sample vial position value, an
error message (see figure 3.4.2.1) will appear. It is
important that you first select the method and then enter the
start and stop positions. If you enter a position number that
is out-of-range, the error will occur when TekLink begins to
run the scheduled method with the out-of-range position.

 Figure 3.4.2.1  Autosampler Position Value Out-of-Range Error Dialog

8. Type the number of times you want the sample to run in
the RPS (runs per sample) field.

9. Click the Send button to transmit the current method
schedule and required files to the active concentrator.
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After sending a method schedule to the active concentrator,
the Operation Status window of the Control Screen displays
the current status information for the active concentrator:
current mode, sample position, and method filename.

The active concentrator will remain in Standby until the
concentrator temperature setpoints (see section 3.4.2.2) are
reached. When setpoints are reached, the active 3100 will
step to Purge Ready. You may begin running samples at this
time.

5.4.2.2 Temperature Zone Status The concentrator and its optional accessories must reach
prescribed temperature setpoints prior to running samples.

To review the Temperature Zone Status for all installed
components:

1. From the Control Screen, select Instrument > Temp
Zone Status.

Figure 3.4.2.2 Temp Zone Status Screen

Note: You may review the status of the temperature zones at any
time.

Note: Selecting the OK button will not send your schedule to the
concentrator and will not save the schedule you have
edited. You must select the Send button in the Schedule
Control to run the schedule. The schedule has been
successfully sent to the concentrator when the bottom of the
Schedule Control screen reads “Schedule Sent”.

10. Click Print to print the current schedule, Save to save
the current schedule to disk, or OK to return to the
Control Screen.
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1. Click the Start control button or select Instrument >
Start to begin a sample run.

The concentrator will proceed to the first operating step in
the scheduled method.

5.5.2 To Initiate a Run

 Figure 3.5.1  TekLink Control Buttons

5.5 Running Samples

5.5.1 Overview of the Control
Buttons

 STEP
Moves the concentrator to the
next operating step during a
sample run.

 AUTO
Resumes normal operation
after the concentrator has been
in Hold.

 DRAIN
Empties the sample
glassware.

 START
Moves the concentrator to the
first step in the operating run.

 HOLD
Prevents the concentrator from
advancing to the next step.
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5.5.3.4 To Step to Standby 1. From the Control Screen, select Instrument > Step
Standby.

Note: A warning screen will ask you whether or not you want to
step the concentrator to Standby. If you select Yes, the
current sample and schedule will be aborted.

5.5.3 Changing the Normal
Operating Sequence During
a Sample Run

1. Click the Step button to advance through the operation
steps (or modes) of an operating sequence.

Note: You can step the instrument even if certain temperature
setpoints for the active concentrator have not yet been
achieved.

Step ends the current operating step and moves the
concentrator to the next operating step of the current
method.

5.5.3.1 Step

5.5.3.2 Hold 1. Click the Hold button to stop the concentrator from
advancing to the next operating step.

While the system is in Hold:

• The Operation Status window of the Control Screen
shows that the status of the active concentrator is in
Hold.

• The dynamic timer continues to progress, allowing you
to monitor the duration of a specific operating step.

• If the timer times out, the concentrator will remain in
the current operating step until the Auto button is
selected.

5.5.3.3 Auto 1. Click the Auto button to take the active concentrator
out of Hold and to resume the normal step progression.

At times, you may find it necessary to interrupt, change,
and/or abort the normal operating sequence of a sample
schedule in progress.
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5.5.3.5 To Step to Bake 1. From the Control Screen, select Instrument > Step to

Bake.

Note: A warning screen will ask you whether or not you want to
step the concentrator to Bake. If you select Yes, the current
sample and  schedule will be aborted.

5.5.3.6 To Reset the Concentrator 1. From the Control Screen, select Instrument > Reset
Instrument.

Note: A warning screen will ask you whether or not you want to
reset the instrument. If you select Yes, the concentrator will:
• abort the current run and schedule
• perform its self tests
• hold in Standby
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5.5.4 Aborting a Schedule and/or

Sample
To abort a schedule and/or sample run that is in progress:

1. From the Control Screen, select Setup > Abort
Schedule/Sample.

 Figure 3.5.4  Abort Schedule/Sample Screen

5.5.4.1 Abort Entire Schedule

5.5.4.2 Abort Current Sample

5.5.4.3 Rerun Sample

5.5.4.4 Complete Sample and Abort

Select Abort Entire Schedule to abort the entire schedule/
sample in progress. The active concentrator will return to
Standby for the first scheduled method.

Note: Selecting Abort Entire Schedule will step the concentrator to
Bake for 9.5 minutes and will drain the contents of the
concentrator glassware.

Select Abort Current Sample to abort the sample in
progress. The active concentrator will then proceed to the
next scheduled sample.

Note: Selecting Abort Current Sample will step the concentrator to
Bake for 9.5 minutes and will drain the contents of the
concentrator glassware.

Select Rerun Sample to abort and rerun the current sample.

Select Complete Sample and Abort to finish running the
current sample and to abort the rest of the schedule. The
active concentrator will finish the sample that is running
and return to beginning of the schedule, go to Standby.
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5.6 TekLink Error

Messages
The following are TekLink dialog messages regarding errors
that may occur.  Please refer to your concentrator user
documentation for descriptions of error messages specific to
3100 operation.

5.6.1 Maximum Failsafe
Exceeded on Heater X*

5.6.2 Minimum Failsafe Exceeded
on Heater X

5.6.3 Open Thermocouple on
Heater X

5.6.5 Power Fail

5.6.8 System Reset

5.6.6 Sample Method Does Not
Match Schedule Position

5.6.7 Self-Test Failure on Heater
X

5.6.9 Setpoint Not Reached on
Heater X

The displayed heater could not reach its setpoint.

* X denotes a particular heater name.

The displayed heater did not pass self test.

The concentrator was reset by either the reset button on the
concentrator or in TekLink. The concentrator will go
through self test after a reset.

The current schedule and the method it is set to use do not
match. Example: An AQUATek 70 method being run on
position 0 (which is the front panel and not the
autosampler); or a 3100 method being run on position 12
which is not a front-panel method.

Power to the concentrator was dropped while it was on.

Displayed heater is disconnected or has opened up.

Displayed heater has dropped below its minimum
allowable temperature.

Displayed heater has exceeded its maximum allowable
temperature.

5.6.4 Out-of-Range Error While
Scheduling

The value (sample vial position number) entered in either
the Start or Stop fields in the Schedule Control screen are
incorrect for the chosen method. When you click OK, the
values return to their defaults.
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5.6.10 AQUATek ASM Not

Responding

5.6.11 AQUATek Sensor Error

5.6.12 AQUATek Heater Error

Make sure the AQUATek 70 and autosampler are turned on
and that they are recognized by and configured in TekLink.
An AQUATek 70 method may be loaded in TekLink while
there is no AQUATek 70.

This error will occur when the base temperature of the hot
water tank inside the AQUATek 70 does not reach temp.
The sensor board screw on top of the hot water tank may be
loose or the sensor board may need replacement.

Note: Please refer to the AQUATek 70 user manual for further
instruction.

This error will occur when the secondary temperature of
the hot water tank inside the AQUATek 70 continues to try
and reach temp for over 20 minutes. The sensor board
screw on top of the hot water tank may be loose, the sensor
board may need replacement, or the hot water tank
assembly may need replacement.

Note: Please refer to the AQUATek 70 user manual for further
instruction.
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6.1 Overview

6.2 Using the Hand-Held
Controller

You use the keypad and display screen to communicate with
the 3100.

• The four-line controller screen displays data entry fields
for programming, menus for selecting commands, and
status information for viewing during operation.

• The controller keypad consists of five variable-function
keys, 13 control keys, and 12 numeric keys.  You can
use the keys to monitor the 3100’s operational status
and program it to run different operating sequences.

A B C

7

1

(-)

4

D

8

2

0

5

E

9

3

.

6

ENTER

STATUS TEMPS

START CONF

PREV

PAGE

SCHED METH

HOLD

AUTO

GOTO

STEP

SHIFT

RESET SETUP

NEXT

PAGE

CLEAR

BKSP

Figure 6-1  Tekmar 3100 Hand-held Controller

With the 3100’s hand-held controller, you can program and
run analytical methods. This section tells you how to:

• Use the 3100’s hand-held controller.

• Read status screens on the hand-held controller and the
front panel screens.

• Power up the 3100 and run self tests.

• Configure the 3100 to operate with your gas
chromatograph (GC).

The hand-held controller consists of a four-line, 20-
character wide, LCD (liquid crystal display) and a 30-key
keypad (Figure 6-1).
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The hand-held controller comes with an interface cable.

1. Locate the jack on the bottom of the front panel display
housing.

2. Plug the end of the cable into the front panel jack.

3. Plug the other end of the cable into the jack on the
bottom of the controller.

Keys in the first row  (labeled A - E) are used to select
options from a screen menu. Their function varies,
depending on the options displayed on the current screen.
For example:

• From the Setup screen, press the A key to display
system information.

• From the Reset screen, press the A key to abort a
schedule.

6.2.1 Installing the Hand-held
Controller

6.2.2 Variable Function Keys

6.2.3 Control Keys The control keys consist of:

• Action keys (RESET, START, AUTO, HOLD, STEP,
and GO TO).  These keys start, control, and stop
analytical runs.

• Screen keys (SETUP, CONF, STATUS, SCHED,
METH, and TEMPS).  These keys display screens that
enable you to define operating parameters, set up
schedules, and review status and temperature.

• Special keys (NEXT/PREV PAGE, BKSP, CLEAR, and
SHIFT).  These keys let you scroll through displays or
manipulate and save data.

Keys with two-part labels have two functions. To use the
function on the lower half of the label, press the control
key. To use the function on the upper half of the label, press
and hold SHIFT while you press the control key.
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6.2.3.1 Action Keys

Table 6-1  Action Key Functions

This key: Performs this function:

RESET

START

GO TO

STEP

HOLD

AUTO

RESET lets you abort a acheduled run, abort the
processing of a single sample, rerun a sample,
or reset the microprocessor to start-up status.
Press and hold SHIFT while you press RESET.

START moves the 3100 to the first step in an
operating run (usually Purge).

GO TO lets you stop an operating run and
immediately go to Standby, Desorb Preheat or
Bake. Press and hold SHIFT while you press GO
TO.

STEP moves the 3100 to the next operating step
in a program.

HOLD prevents the 3100 from advancing to the
next step. Press and hold SHIFT while you press
HOLD.

AUTO resumes normal operation after the 3100
has been in HOLD.
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6.2.3.2 Screen Keys

Table 6-2  Screen Key Functions

METH

SETUP

CONF

SCHED

STATUS

TEMPS

SETUP allows you to access basic system
information, set the time and date, and adjust
contrast for the status screen. Press and hold
SHIFT while you press SETUP.

CONF displays the Configuration screens that
allow you to configure the 3100 to run with your
GC (gas chromatograph).

SCHED displays the Scheduling screen that
allows you to edit and enable method schedules
(processing timetables that define sample
positions and the order in which selected methods
will be run) and review the current status of
scheduled runs.

METH displays the Select Method screen that
allows you to select a method and change its
parameters.

STATUS displays a Status screen that shows the
current operating step and its controlling
parameters.

TEMPS displays the Temperatures screens, which
show temperature setpoints and actual readings
for all actively controlled temperature zones.

This key: Performs this function:
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6.2.3.3 Special Keys

Table 6-3  Special Key Functions

NEXT
PAGE

PREV
PAGE

CLEAR

BKSP

ENTER

SHIFT

For screens that contain more than one screen of
data, NEXT PAGE scrolls down to display the next
screen of data.

For screens that contain more than one screen of
data, PREV PAGE scrolls up to display the previous
screen of data.

CLEAR erases an entry completely. Press and hold
SHIFT while you press CLEAR.

BKSP deletes the character beneath the cursor.

ENTER saves your entry and moves the cursor to
the next data entry field.

SHIFT activates the light gray labeled functions on
two-part control keys. Press SHIFT, hold it down,
and press the selected key to execute the shifted
function.

This key: Performs this function:

You use the numeric keys 0 through 9, . (decimal point) and
- (negative sign) for entering numeric data such as time or
temperature parameters.

To enter numeric data:

1. Press the desired numeric keys, including the decimal
place and the negative sign, if required.

2. Press the ENTER key.

To clear the last character, press BKSP.

To clear an entry completely, press and hold SHIFT while
you press CLEAR.

6.2.4 Numeric Keys
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The 3100 hand-held controller uses several types of
display:

• A two-line, front panel status display.

• Status screens (on the hand-held controller).

• Menu screens (on the hand-held controller).

• Action screens (on the hand-held controller).

• Data entry screens (on the hand-held controller).

During each operating step of a run, the front panel screen
continuously displays two lines of status information.

When the temperature setpoint is the controlling parameter
for the step, the front panel screen displays the information
illustrated in Figure 6-2.

6.3 Using Screens

6.3.1 Front Panel Status
Display

6.3.1.1 Temperature Parameter
Display

Figure 6-2  Front Panel Status Screen

Each part of the screen above is labeled with a number. See
the matching numbers below to find out more about each
part of the screen.

1 The name of the operating step appears on the first line, at the left
margin.

2 The number of the currently-active method appears on the first line, at the
right margin. If the 3100 is running a method schedule, this position
shows the currently-active method number and currently-active sample
position. For example, M7P04 indicates that method 7
is running on sample position 4.

3 The name of the heated or cooled zone and its current measured
temperature appear at the left on the second line.  The display updates
this value continuously as the temperature changes.

4 The temperature setpoint for the step appears at the right on the second
line.

Standby1 2M01

MCS3 97-> 4230C
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When a time setpoint is the controlling parameter for the
step, the front panel screen displays the information
illustrated in Figure 6-3.

6.3.1.2 Time Parameter Display

Figure 6-3  Front Panel Timer Screen

1 The name of the operating step appears on the first line, at the left margin.
2 The elapsed time appears on the second line. The display updates this

value continuously.
3 The total time setpoint appears at the right on the second line.

6.3.2 Status Screens

GC Synchronize1 M01

21.00 - 310.00

To display an operating status screen at any point during
operation, press the STATUS key. The 3100 displays an
Operating Status screen like the one in Figure 6-4.

6.3.2.1 Displaying Operating Status
Screens

Figure 6-4  Desorb Screen

Desorb1    2M01

  30.38 - 42.00

Ambient Trap 535-> 6225C

A status screen may display:

• A listing of temperatures for all the actively-controlled
heated or cooled zones in the 3100.

• Information about the current status of a run. Each
operating step has a corresponding Operating Status
screen. You can check the progress of  the run by
reviewing the current Operating Status screen. This
section describes the Operating Status Screens.
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Table 6-4  Menu Screens

Operating Status screens display the following information:
1 The name of the operating step appears on the first line, at the left

margin.
2 The number of the currently-active method appears on the first line, at the

right margin. If the 3100 is running a method schedule, this position
shows the currently-active method number and currently-active sample
position. For example, M7P04 indicates that method 7 is running on
sample position 4.

3 For timed steps, the elapsed time appears on the third line. The display
updates this value continuously.

4 For timed steps, the total time setpoint appears at the right on the third
line.

5 For temperature-dependent steps, the name of the heated or cooled
component and its current measured temperature appears at the left on
the fourth line. The display updates the temperature value continuously.

6 For temperature-dependent steps, the temperature setpoint appears at
the right on the fourth line.

6.3.2.2 Reading the Fields

6.3.3 Menu Screens Menu screens offer lists of variable-function key options.
You press the indicated key to make a selection. Table 6-4
on the following page shows some of the menu screens and
the keys which access them.

to display these menu screen choices:Press this key:

SETUP

SCHED

METH

C (from the
Select Method
screen)

A = System Info
B = Time/Date

A = Sample Status
C = Commands
E = Edit Schedule

Select  Method
C = Commands
E = Edit

Commands: Method
A = Change Type
C = Restore Default
E = Copy Method
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Table 6-5  Action Screens

Figure 6-5  Data Entry Screen

A data entry screen can display fields like the ones shown
in Figure 6-5.

• A - fields that allow you to select one of several
available options.

• B - fields into which you enter numbers.

6.3.5 Data Entry Screens

A

B

GC Start DesEnd

CryoFocuser  On

GC Cycle Time  45.00

more...

A = Abort Schedule
B = Abort Sample
C = Rerun Sample
D = Complete and Abort
A = Continue Testing
B = Ignore Self-test
C = Restore Previous

A = Run Schedule
B = Update* Schedule
C = Clear Schedule

A = GoTo Mode
B = Manual Operation

to display these choices:Press this key:

RESET

STEP (from a
Self-test Screen)

C (from the
Scheduling
Screen

GO TO

Various keys
from various
screens

A = Abort (cancel action)
E = Execute (perform selected action)

An action screen presents a choice of variable function
keys. It looks like a menu screen, but there is a difference:
pressing a variable function key from a menu screen
displays another screen. Pressing a key from one of the
action screens shown in Table 6-5 on the following page
initiates an action.

6.3.4 Action Screens
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6.3.5.1 Option Selection Fields To review available options and select one:

1. If the cursor is on the option to be changed, press any
number key to toggle the status field. Each time you
press a number key, the field displays the next available
option. When the desired option is displayed, press
ENTER to select it. The cursor moves to the next line.

2. If the cursor is not on the option you wish to change,
press ENTER to move the cursor, one line at a time.
When the cursor reaches the bottom of the screen, press
ENTER to move it back to the top of the screen.

3. Press any number key to toggle the status field, as
described in step 1.

To enter a number into a data entry field:

1. If the cursor is on the desired field, type the appropriate
numbers in the field; then press ENTER.

2. If the cursor is not on the desired field, press ENTER to
move the cursor, one line at a time. When the cursor
reaches the bottom of the screen, press ENTER to move
it back to the top of the screen.

3. Type the numbers in the field; then press ENTER.

To begin 3100 operation:

1. Turn on the 3100. (The switch is on the rear panel.) The
3100 loads program data into memory, performs
initialization tasks, and briefly displays the message,
"Initialization successful" on the front panel screens.

2. The screen on the front panel (Figure 6-6) shows the
date and time of  the last power loss.

6.3.5.2 Data Entry Fields

6.4 Getting Started

Figure 6-6  Initial Front Panel Screen

The screen on the controller (Figure 6-7 on the following
page) shows the same date and time.

Power Fail

12/20/98  10:12:14
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Figure 6-7  Start-up Screen

3. Press ENTER. The screen shown in Figure 6-7 appears
briefly.

Figure 6-8  Tekmar Identification Screen

6.4.1 Performing Self Tests

The Identification screen is followed almost immediately
by the first Self Test screen (Figure 6-9).

Figure 6-9  Self Test Screen 1

The screen lists the heaters being tested. To test its heaters:

• The 3100 activates and establishes an incremental
setpoint for each heater: 3°C above its current
temperature for the valve oven heater and 5°C above
current temperature for the other heaters.

• When a listed heater reaches the test temperature, it
disappears from the listing. As heaters drop off the
listing, the last line shows elapsed time as it progresses
to a two-minute limit.

3100 Concentrator

Copyright (c) 1992,98

Tekmar Company

Power Fail

System Error

12/20/98 10:12:14

'ENTER' to clear

Self Test Heaters

BOT Htr 41-> 46C

Amb Trap 54-> 55C

MCS 59-> 64C
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6.4.2 Exiting the Self Tests At any point during the self tests, you can suspend self

testing.  When you press STEP, the 3100 displays the Self
Test Status screen (Figure 6-10).

The Self Test Status action screen offers three options for
handling pending (uncompleted) self tests. You can:

• Press the A key to return to the previous screen and
complete all pending tests.

• Press the B key to skip the pending self tests and
position the unit to run the first sample of the schedule.

• Press the C key to restore previous self test results for
the pending tests.  This option accepts the results of the
self tests that were run the last time the unit was
powered up.

Figure 6-10  Self Test Status Screen

6.4.3 Clearing a Self Test Error

Figure 6-11   Front Panel Message Screen

2. The screen that appears on the hand-held controller
(Figure 6-12) lists the region that failed and provides
instructions for clearing the error.

Figure  6-12   Controller Message Screen

Self Test Status

<A> =Continue Testing

B =Ignore Self test

C =Restore Previous

Self test Fail

Region: Sample

Self Test Fail

System Error

12/20/98 10:30:00

'ENTER' to Clear

1. If a component fails to reach the setpoint within the
time limit, the 3100 displays an error message on both
screens.  The screen on the front panel (Figure 6-11)
specifies the region that failed.
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3. After you have corrected the problem, press ENTER to

clear the error message. The 3100 displays the Reset
screen.

4. Press SHIFT + RESET; the Tekmar Identification
screen appears briefly, followed by the System Reset
screen (Figure 6-13).

Figure 6-13  System Reset Screen
5. Press ENTER. The 3100 performs the self tests again. If

you have not corrected the problem, the same region
will fail again. The unit will not run until it passes the
self tests.

6. When the self tests are complete, the hand-held
controller displays the Standby status screen for the
current method.

Figure 6-14  Setup Screen

2. From the Setup screen, press the B key. The Date and
Time screen (Figure 6-15) appears.

Figure 6-15  Date and Time Screen

6.4.4 Setting the Date and Time

Mon Dec 21 1998

12/21/98 10:32:53

Press 'E' to Edit

<A>=System Info

B =Time/Date

System Reset

System Error

12/21/98 10:30:00

'ENTER' to Clear

Use the SETUP key to establish or confirm the system
clock setting.
1. From any screen, press and hold the SHIFT key; then

press SETUP.  The 3100 displays the Setup screen
(Figure 6-14).

• The first line on the Date and Time screen shows the day of the week,
the month, the date and the year.

• The second line shows date (MM/DD/YY) and time (HH:MM:SS).
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3. Press the E key. The Date and Time Editing screen

(Figure 6-16) appears, with the cursor on the last
character in the third line.

4. Type the date, using numerals to indicate month, day,
and year. Use the period (.) to mark each separation
between them. For example, Enter December 21, 1998
as 12.21.98. Press ENTER. The cursor moves to the end
of the next line.

5. Repeat step 4 for the time line, using hours, minutes,
and seconds, in military time. For example: Enter 3:13
p.m. as 15.13. Press ENTER.

Figure 6-17  System Information Screen

• The first line gives the model number of the instrument.
• The second line shows the version of the ROM chip currently installed in

the 3100.
• The last line shows the time since power up or since the last system

reset.

3. After reviewing the system information, you can press
STATUS to exit the System Information screen and
display the current status screen.

6.4.5 Checking the Unit Type and
ROM Version

Figure 6-16  Date and Time Editing Screen

Use '.' as separator

Date: 12/21/98

Time: 10:53:41

Unit Type 3100

ROM Ver:5.00

UpTime - 0:01:47.15

1. From any screen, press and hold the SHIFT key; then
press SETUP.  The 3100 displays the Setup screen
(Figure 6-14).

2. From the Setup screen, press the A key. The System
Information screen (Figure 6-17) appears.
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6.5.1 Specify the GC Port Type

You can use the Configuration screen (Figure 6-18) to
define essential aspects of 3100 operation.  Press the CONF
key to display the Configuration screen, with the cursor on
the first line.

6.5 Configuring the 3100

The Configuration screen (Figure 6-18) displays the
following options:

<A> GC I/O Port - specifies the type of GC you are using.

<B> Gas Flows - indicates whether or not the sample
pathway is swept with gas during the Standby step.

<C> Installed Option - indicates whether a cooling
accessory is installed.

The following sections describe the configuration options
and tell you how to use them.

Note: You must specify a GC Port or the 3100 may not work with
your GC.

On the Configuration screen, select the option on the first
line (if necessary); the selected option letter appears with
brackets (<A>).  Press ENTER to display the GC
Configuration screen (Figure 6-19).

Figure 6-18 Configuration Screen

Figure 6-19  GC Configuration Screen

GC Port Standard
Handshaking  On

more...

Configuration
<A> =GC I/O Port
B =Gas flows
C =Installed Option
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The instructions shipped with your 3100-to-GC interface
cable tells you how to specify the type of GC you are using.
If you do not have these instructions, refer to table 3-2 on
the next pages. Find your GC and the corresponding GC
Port on the table and follow the steps below. If you do not
have interface cable instructions and you cannot find your
GC on the table, see the next section.

1. If your GC is Standard, press ENTER to select Standard
as the GC Port. The 3100 is now configured to operate
with your GC. (Most GCs operate using Standard as the
GC Port.) Skip the next steps and go to Section 6.5.2,
Specify Handshaking.

2. If your GC is not standard, select User. Press any
number key to select User as the GC Port, then press the
NEXT PAGE key to display the Special GC Type
screen (Figure 6-20).

3. Enter the User GC Type number. If you do not know
which number to enter, find your GC on Table 6-7.
Enter the number that is in the GC Type Number
column.

From the GC Configuration screen, you can specify the
type of GC you are using. The first line displays GC Port, a
classification based on the input-output characteristics of
the GC as it interacts with the 3100.

Note: The GC is interfaced to the 3100 via an interface cable,
which runs from the GC to the 25-pin connector on the
3100’s GC I/O card. Table 6-6 lists the available GC Port
options.

Table 6-6  Available GC Port Types

A standard GC (all input and output signals
from a standard GC are normally-open relay
closures or TTL active-low signals)

The GC supplies or accepts all normally-
closed relay closures, all TTL active-high
signals, a combination of normally-open and
normally-closed relays or a combination of
TTL active-low and TTL active-high signals.

Standard

User
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Figure 6-20  Special GC Type Screen

Special GC Type

User GC Type 0

See Manual for Help

To access the Configuration screen, press the CONF key.
The second line on the Configuration screen displays the
3100-GC handshaking characteristics - whether or not the
3100 will wait for a signal from the GC (a handshake)
before sending a sample. The available options are:

• On - the GC interface port operates normally.

• Off - the GC interface port operates with no input or
output signals between the 3100 and the GC. The 3100
will cycle continuously.

1. Press any number key to toggle the option ON or OFF.

2. Press ENTER to accept the currently-displayed option.

To access the Configuration screen, press the CONF key.
On the Configuration screen, select the option on the
second line; the selected option letter appears with brackets
(<B>).  Press ENTER to display the Gas Flows
Configuration screen (Figure 6-21).

6.5.3 Specify Gas Flows

Figure 6-21  Gas Flows Configuration Screen

Standby Flow On

6.5.2 Specify Handshaking
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The screen illustrated above indicates that Standby Flow is
turned on. This setting forces sample gas flow through the
sample pathway, bypassing the sample vessel (bypass valve
ON) in the Standby mode. You can shut off flow through
the sample pathway by selecting the OFF option for
Standby Flow. This closes the sample, bypass, and vent
valves.

On the Configuration screen, select the option on the third
line; the selected option letter appears with brackets (<C>).
Press ENTER; the Installed Options Configuration screen
appears (Figure 6-22) with the Trap Region field set to
Ambient.

6.5.4 Specify Installed Options

Figure 6-22  Installed Options Configuration Screen

Select one of the following values for the Trap Region field:

• Ambient - the 3100 uses the standard internal trap at
ambient temperature.

• TurboCool - the 3100 operates at cryogenic
temperatures with a TurboCool accessory installed.

• Cryo - this option will be included in future versions of
the 3100 operating software.

Trap Region Ambient
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To edit a method, follow these steps:

• Specify the method (from 1 - 16) that you wish to
change.

• Indicate the system configuration for the selected
method.

• Change parameters to customize the method.

To select a method for editing:

1. Power up the system.  The 3100 displays the Standby
screen for Method 1.

2. Press the METH key. The 3100 displays the Method
screen (Figure 6-23), with the cursor at the last position
on the second line.

6.7.1 Select a Method

At first power up, the 3100 is scheduled to run Method 1.
The concentrator automatically performs self tests and
displays the Standby screen for Method 1. When the heaters
and coolers have reached the default temperature setpoints
for Method 1, the hand-held controller displays a screen
with the prompt, "Press START to Begin". At this point,
you can:

• Press START to run Method 1 with its default
parameters.

• Follow the instructions Scheduling and Running
Samples to change the method schedule and run another
default method.

The 3100 stores 16 methods, each with a predefined set of
default parameters.

6.6 Understanding Default
Methods

Temperatures above 230°C will damage Tenax traps. You
may need to edit the method(s) so that the temperature will
not exceed the maximum allowable temperature for your
traps.

CAUTION

For each supported system configuration, the 3100 displays
a different set of method editing screens. The method
editing screens list the parameters associated with the
operating steps for the selected method. You can create a
customized method by using the method editing screens to
modify parameters to meet your analytical requirements.

6.7 Creating Custom
Methods
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6.7.2 Indicate the System
Configuration

Figure 6-24  Method Commands Screen

Commands: Method 1

<A>=Change Type

C =Restore Method

E =Copy Method

• Line 2 shows the number of the active method (1
through 16). The active method (the startup default) is
Method 1.

• Line 3 indicates the system configuration for the
currently-active method. The default type for Method 1
is 3100.

3. At the Method field, enter the number of the method to
be changed; then press ENTER.

To indicate the system configuration to be supported by the
selected method:

1. Press the C key to display the Method Commands
screen (Figure 6-24).

Select Method

Method 1

Type 3100

<C>=Commands  E=Edit

Figure 6-23  Method Screen

2. Press the A key (or press ENTER when A is highlighted
with <> brackets) to display the Change Method Type
screen (Figure 6-25), with the cursor on the third line.

Figure 6-25  Change Method Type Screen

Change Method Type

Method 1

Type 3100

<A>=Abort E=Execute
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3. Press any number key. The value in the Type field

toggles each time you press a number key. The
available options are:

• 3100 ................. Front panel sample position only.
• 20XX ............... ALS 2016/2032 autosampler with

the 3100.
• AQUATek 50 ... AQUATek 50 with the 3100.
• AQUATek XX . AQUATek 50 and ALS

autosampler with the 3100.
• AQUATek 70 ... AQUATek 70 autosampler with

3100
• 60XX ............... AEROTrap autosampler with the

3100.
4. When the screen shows the correct value for the Type

field, press the E key to accept the value and return to
the Select Method screen.

Note: To exit the Method Commands screen without making any
changes,  press the A key. The 3100 ignores any changes
you may have entered on the Method Commands screen
and displays the Select Method screen.

6.7.3 Copy an Existing Method If the new method will differ from an existing method in
only a few parameter values, you can copy the parameters
for an existing method into memory and use them as the
basis for a new method.

1. On the main Method screen, press the C key to display
the Method Commands screen.

2. Press the E key to display the Copying Method screen
(Figure 6-26), with the cursor at the end of the second
line.

Figure 6-26 Copying Method Screen

Copying Method

Source 1

Destination 1

<A>=Abort E=Execute

• Line 2 shows the number of the method to be copied
(Source).

• Line 3 shows the number of the method into which the
Source method will be copied (Destination).
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3. Type the number of the method to be copied; then press

ENTER.  The cursor moves to the last position on the
next line.

4. Type the number of the method to receive the copy.
Press ENTER.

5. Press the E key to execute the copy and return to the
Select Method screen.

Note: To exit the Copying Method screen without making any
changes, press the A key to abort. The 3100 ignores any
changes you may have entered on the Copying Method
screen and displays the Select Method screen.

6.8 Editing 3100 Methods To begin editing the selected method, press the E key from
the Method screen. For methods 1, 3, 5, 7, 9, and 11, the
screen displays the sequence of editing screens for front
panel sample methods (Type 3100) shown in Table 6-8.

6.8.1 Using the Editing Screens

Table 6-8  Editing Screens for 3100 Methods

— setpoint for transfer line

— setpoint for the valve oven and BOT

— setpoint for sample mount heater (optional)

— setpoint for the Moisture Control System line.

— trap temperature must fall below setpoint

— setpoint for cooling the trap when a TurboCool
accessory is installed.

— whether the sample heater is activated or not.

— how long the sample is swept with purge gas
before being purged.

— how long the sample is heated before purge.

— setpoint for the sample heater (optional)

— how long the sample is purged.

— how long the gas flows thtrough the trap, but
not through the sample glassware.

— setpoint for the MCS during the Desorb step

Line Temp 150

Valve Temp 150

Mount Temp 40

MCS Line Temp  40

Purge Ready Temp 30

TurboCool Temp -20

more . . .

Sample Heater Off

PrePurge Time  3.00

PreHeat Time 5.00

Sample Temp 40

Purge Time 11.00

DryPurge Time 0.00

MCS Des Temp 40

more. . .
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GC Start DesStart

Cryo Focuser Off

GC Cycle Time 0.00

more . . .

Cryo Standby 100

CryoFocus Temp -150

Inject Time 1.00

Cryo Inj Temp 180

Desorb PreHeat 245

Desorb Time 4.00

Desorb Temp 250

Sample Drain Off

Bake Time 10.00

Bake Temp 280

BGB  On Delay 2.00

MCS Bake Temp 310

— tells when the GC receives its START signal.

— whether a Cryofocusing Module (CM) is
installed.

— length of time required for the GC to process
a  sample.

— temperature of the inactive CM.
— low-temperature setpoint for trapping

analytes.
— how long the cryo heater remains at inject

temp.
— cryo heater temp. when analytes are

released.

— temperature trap is heated to before trap
desorb.

— length of the trap Desorb step.

— trap temperature during the Desorb step.

— whether automatic drain is ON or OFF.

— duration of the Trap Bake step.

— trap temperature during the Bake step.

— whether Bake Gas Bypass is ON or OFF and
length of  BGB delay.

— MCS temperature during Bake step.

If your analytical procedures dictate the use of parameters
other than the defaults, you may modify the values to meet
your analytical needs.

6.8.2 Selecting Parameters

Table 6-8  Editing Screens for 3100 Methods
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A Desorb Preheat temperature of 175°C and a Desorb tem-
perature of 180°C will not efficiently release compounds that
are heavier than xylenes. Use a Desorb Preheat temperature of
220°C and a Desorb temperature of 225°C (except when using
the Vocarb 3100 trap) to release all compounds.

The table below lists recommended parameter values for
the MCS.

Table 6-9  Recommended Parameter Values for the MCS

1 If you are looking for xylenes and heavier compounds, specify 50°C for
MCS Desorb.

2 If not splitting (i.e., packed column), specify 35°C for MCS Desorb.
3 This can be achieved by using the MCS jumper - Tekmar Part Number:

14-6011-002

6.9 Moisture Control
System (MCS)
Parameters

Desorb MCS MCS MCS Line Valve
Flow Desorb Line Bake Temp Temp
0.5-4 ml/min 50°C 150°C 310°C 150°C 150°C

7-12 ml/min 35-50°C1 150°C 310°C 150°C 150°C

12-20 ml/min 35°C 150°C 310°C 150°C 150°C

(no split)

> or = 20 ml/min bypass3 35°C 35°C 150°C 150°C

(split only)2
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You can undo changes made to default parameters for any
method.

1. Press METH on the keypad.

2. At the the method field, enter the number of the method
with the defaults you wish to restore; then press
ENTER.

3. Press the C key to display the Method Commands
screen (Figure 6-27).

Figure 6-27  Method Command Screen

4. Press the C key to display the Restore Default screen
(Figure 6-28).

Figure 6-28  Restore Default Screen

5. Press the E key to execute the command. The 3100:

• Erases any custom parameter values that have been
programmed for
the current method.

• Restores the default values.

• Returns to the Select Method screen display.

Note: To exit the Restore Default screen without making any
changes,  press the A key to abort. The 3100 ignores any
changes or commands you may have entered on the
Restore Default screen and displays the Select Method
screen.

6.10 Restoring Default
Parameters

Commands: Method 1

<A>=Change Type

C =Restore Default

E =Copy Method

Restore Default

Method 1

<A>=Abort E=Execute
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You must set up a method schedule, or processing
timetable, to “tell” the 3100 which method(s) will be run on
which sample(s). This is true regardless of whether you are
using a single position unit or a unit with an autosampler
attached. When you use the 3100 without an autosampler,
you can specify the number and sequence of methods to be
run on a single sample. When you use the 3100 with one or
more autosamplers, a method schedule defines:

· The method(s) to be run.

· Start and stop positions for each method.

· A sequential order for each sample to be run.

· The number of runs per sample.

Briefly, here is how you can create and activate a method
schedule:

1. Establish a desired method schedule.

2. Enter the desired schedule parameters.

3. Run the schedule.

Before you set up your method schedule, consider:

· The number and type of samples to be run.

· The method required for each sample.

· The preferred sequence in which to run the samples.

6.11 Creating a New
Schedule

6.11.1 Establishing a Method
Schedule

1. From any screen, press the SCHED key. The Scheduling
screen (Figure 6-29) appears.

Figure 6-29  Scheduling Screen

6.11.2 Entering Schedule
Parameters

2. At the Scheduling screen, press E to display the
Schedule Editing screen (Figure 6-30), with the cursor
on the first position in the Start column.

         Scheduling
     <A>=Sample Status
      C =Commands
      E =Edit Schedule
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Figure 6-30  Schedule Editing Screen

Each row specifies:

• The number of a method to be run (in the Meth
column). The default method is Method 1.

• The position of the first sample (in the Start column)
and the last sample (in the Stop column) to be run
according to the specified method. The default sample
start and stop positions are 0, which is the number
assigned to the sample that is run on the 3100.

• The number of times each sample will be run (in the
RPS, Runs per Sample column).

You can change the schedule in several ways. You can:

• Specify a different method to be run by changing the
number in the Meth column.

• Specify different start and stop positions for a given
method by changing the numbers in the Start and Stop
columns.

• Indicate that a sample position should be run more than
once by changing the number in the RPS column.

To make changes in the method schedule:

1. Type the desired parameters into each field, pressing
ENTER after each entry. The cursor moves to the next
field in the row. When you reach the end of a row, the
cursor moves to the first field in the next row.

2. If necessary, press NEXT PAGE to display succeeding
screens of Schedule Edit parameters: Rows 4-6, 7-9,
and 10-12.

3. When you have entered the complete schedule, press
the SCHED key to return to the Scheduling screen.

6.11.2.1Review Default Schedule
Parameters

The schedule in figure 6-30 shows the default schedule
parameters for the 3100. The Schedule Editing screen has
four columns and up to 12 rows.

6.11.2.2Changing the Schedule

 Start   Stop    Meth   RPS
1) 0 0 1 1
2) 0 0 0 1
3) 0 0 0 1
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Figure 6-31 shows a typical schedule, for running two Type
20XX methods (2 and 4) on specified sample positions.

Figure 6-31  Schedule Editing Screen

To enter this schedule:

1. On the first row, enter 1, 8, 2, and 2 in their respective
columns. These entries specify that:

• The samples in positions 1 through 8 will be run
according to  Method 2, with each sample being run
twice.

• Method 2 is a Type 20XX method; if you schedule
position 8 for a method that has no position 8 (a
Type 3100 method, for example), the 3100 displays
an error message when you try to run the schedule.

2. On the second row, enter 9, 12, 4, and 1 in their
respective columns.  These entries specify that samples
9 through 12 will be run according to Method 4, with
each sample being run through the method once.

To enter this schedule:
1. On the first row, enter 0, 0, 3, and 3 in their respective

columns. These entries specify that Method 3 (a 3100
method) will be run on the 3100’s front panel sample.
The sample will be run three times.

Note: If you are setting up a schedule to be run on an
autosampler, be sure to specify methods that are the correct
type for your system configuration.  If you have ROM (read-
only memory) version 2.10 or greater, a stop position that is
less then the start position will cause the 3100 to run sample
#1 on the autosampler after the last sample is run.

6.11.2.3Sample Schedules

Figure 6-32  Sample Schedule Editing Screen

  Start  Stop Meth RPS
1) 1 8 2 2
2) 9 12 4 1
3) 0 0 0 1

 Start   Stop    Meth   RPS
1) 0 0 3 3
2) 0 0 0 1
3) 0 0 0 1
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To run a schedule:

1. From the Scheduling screen, press the C key to display
the Schedule Commands screen (Figure 6-33).

Figure 6-33  Schedule Commands Screen

2. Press A (Run Schedule). The 3100 starts the current
schedule and displays the Standby Status screen (Figure
6-34) for the first sample.

You can edit a schedule in the middle of a run. From the
operating step Status screen press SCHED.
1. Allow the current schedule to run its course. After the

3100 completes the currently-running schedule, it
automatically builds and runs the new schedule (the one
you just entered). ~or~

2. Build the new schedule and run it from the beginning by
following these steps:
a. Press the SCHED key to display the Scheduling

screen.
b. Press C to display the Schedule Commands screen.
c. Press A (Run Schedule). The new schedule is built,

and the 3100 goes into Standby as it prepares to
start running the new schedule.~or~

3. If your changes affect only those parts of the schedule
that have not yet been run, combine the new schedule
with the old and continue to run from your current
position.
a. Press the SCHED key to display the Scheduling

screen.
b. Press C to display the Schedule Commands screen.
c. Press B (Update* Schedule). The 3100 incorporates

the new schedule into the old and continues to run.

Figure 6-34  Standby Status Screen

6.11.3 Running the Schedule

6.11.4 Changing the Schedule
During a Run

Schedule Commands
<A>=Run Schedule
B =Update Schedule
C =Clear Schedule

Standby        M1P01
BOT Htr     97->200C
MCS         30->100C
XferLine   150->250C

During Standby, the 3100 establishes initial conditions.
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6.11.5 Restoring the Default

Schedule
To restore the default schedule (Method 1 for a front panel
sample on the 3100), press C (Clear Schedule) on the
Schedule Commands screen..

While the 3100 is operating, it shows a status screen
indicating the current operating step and its active
parameters. The operating steps vary, depending on the type
of method you are using. This example shows the operating
steps for running default Method 1.

6.12 Running a Sample

When all Standby setpoints have been reached, the Purge
Ready screen (Figure 6-35) appears.

Figure 6-35  Purge Ready Screen

6.12.1 Purge Ready

Note: If you have not yet leak checked the 3100, do so before you
start a run.

Purge Ready waits for a start signal from the user (via the
START key on the keypad), or from an accessory, before
proceeding to the next step.

• To begin a run, press START on the terminal keypad.

The 3100 proceeds to the next step in the scheduled
method. As the 3100 goes through a run, it displays a status
screen for each step.

Note: You can always display a status screen by pressing
STATUS on the  keypad. For  example, if you are editing
one method while running another, you can press STATUS
to review conditions for the cur-rently active operating step.
You can also review this information on the 3100’s front
panel display.

Purge Ready    M1P00

Press START to Begin
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Figure 6-38  Desorb Ready Screen

This step (see Figure 6-39) heats the trap to a specified
temperature before desorbing analytes.

Figure 6-39  Desorb Preheat Screen

6.12.3 MCS Cooldown

6.12.5 Desorb Preheat

MCS Cooldown (see Figure 6-37) lowers the temperature of
the moisture control system to its moisture removal setpoint.
This prepares it for gas flow from the trap to the GC.

Figure 6-37  MCS Cooldown Screen

This step (see Figure 6-38) allows the 3100 to wait for a GC
READY signal from the gas chromatograph.

6.12.4 Desorb Ready

MCS Cooldown    M1P00

MCS 81-> 35C

Desorb Ready    M1P00

Waiting for GC Ready

Desorb Preheat M1P00

Amb Trap  168-> 220C

6.12.2 Purge

Figure 6-36  Purge Screen

The Purge step sends sample gas through the sample
glassware for a specified time. The gas flow removes
analytes from the sample and sends them to the internal
trap.

Purge         M1P00

         027->11.00
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This step (see Figure 6-40) backflushes the trap onto the
GC (or onto the Cryofocusing Module, if installed).

Figure 6-40  Desorb Screen

6.12.6 Desorb

Desorb     M1P00

   0.37->  2.00
Amb Trap   224-> 225C

Figure 6-41  Bake Screen

• Displays the Standby screen while establishing initial
conditions for  the next run.

• Enters a GC Synchronize step (see Figure 6-43) that
adds enough time to the 3100 operating cycle to
synchronize it with the GC cycle. (When the 3100 is
running multiple samples or multiple runs on the same
sample, GC Synchronize replaces Purge Ready between
runs.)

6.12.7 Bake This step (see Figure 6-41) heats the trap and MCS; then it
sends clean gas through the sample pathway to sweep it clear
of residual moisture and organic contaminants.

If the schedule calls for another run at the end of the Bake
step, the 3100:

• Loads the required method into memory while
displaying the screen in Figure 6-42.

6.13 Making Subsequent
Runs

Figure 6-42  Loading Method Screen

Bake          M1P00

0.37->  2.00
Amb Trap  224-> 225c

Next Sample

Loading Method...
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Figure 6-45 Go To Commands Screen

At any point during a run, you can display a Manual
Operations screen that allows you to:

• Toggle the position of the drain valve to control the flow
of liquid draining from the sample.

• Toggle the position of the vent valve to control back
pressure on the sample gas feed.

To display the Manual Operations screen:

1. Press SHIFT-GO TO. The 3100 displays the screen in
Figure 6-45.

Figure 6-46  Manual Operations Screen

6.14 Controlling Manual
Operations

2. Press B. The Manual Operations screen (Figure 6-46.)

     Goto Commands

  A =Goto Mode
 <B>=Manual Operation

<A>=Drain
 B =Feed Pressure

 Manual Operations

Figure 6-43  GC Synchronize Screen

• Instructs the autosampler to activate its multi-position
valve and switch to the correct sample position while
displaying the screen in Figure 6-44.

Figure 6-44  MPV Positioning Screen

GC Synchronize

 0.00 -> 5.00

20XX Position M2P03

2016 MPV Position:3
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The drain valve allows the sample glassware to be emptied.
When it is open, liquid and gas can be forced out of the
sample glassware into the drain system and out the back
panel drain. If your ROM (read-only memory) version is
prior to 2.10, you can drain only during Standby, Purge
Ready, and Desorb.

To toggle the drain open or closed:

1. From the Manual Operations screen, press A to open the
drain valve.

2. The letter D flashes in the upper right of the screen, in
front of the method number.

3. To close the drain valve and turn off the flashing D,
repeat step 1.

6.14.1  Manual Drain

6.15 Interrupting a Run

6.14.2 Feed Pressure Setting The vent valve allows sample gas to exit the sample
pathway through a front panel vent. When it is closed,
pressure builds up in the sample pathway. This is used to
set the feed pressure (it eliminates TPC effects). If your
ROM (read-only memory) version is prior to 2.10, you can
select feed pressure only during Standby and Purge Ready.

To toggle the vent open or closed:

1. From the Manual Operations screen, press B to close
the vent valve.

2. P flashes in the upper right of the screen, in front of the
method number.

3. To open the vent valve and turn off the flashing P,
repeat step 1.

At any point during a run, you can use control keys on the
terminal keypad to:

• Change the normal sequence of operating steps,

• Abort part or all of the scheduled runs, or

• Review the current status of a method schedule.



6 -36  Tekmar 3100 Purge and Trap Concentrator User Manual

Using the Hand-held to Process Samples6

Figure 6-48  Go To Mode Screen

Figure 6-47  Go To Commands Screen

a. Press A at the Goto commands screen to display the
Goto Mode screen (Figure 6-48).

b. Press A to display the Reset screen (Figure 6-49).
Follow the instructions in the next section Reset the
Schedule to select one of the Reset options and
return to the Standby step.

c. Press B to for the Desorb Preheat operating step.
This prepares the 3100 to desorb the internal trap.

d. Press C to go to the Bake operating step. This cleans
out the concentrator.

• Also, to change the the normal progression through an
operating sequence, press Shift-Hold. The concentrator
goes into HOLD mode and does not advance to the next
operating step. While the system is in  HOLD, (1)
 the letter H flashes in the upper right corner of the
screen, just in front of the method designation, (2)
active timers continue to advance, allowing you to
monitor the duration of a particular step, and (3) when
the timer times out, the concentrator remains in the
current operating step.

• Press AUTO to resume normal step progression.

Goto Commands

<A>=Goto Mode
 B =Manual Operation

     Goto Mode
<A>=Standby
 B =Desorb Preheat
 C =Bake

To change the normal progression through an operating
sequence, you can use one of the following keys:
• Press STEP to step through an operating sequence,

regardless of the setpotints for the currently-active
method. Pressing STEP ends the current operating step
and moves the 3100 to the next step specified in the
active method.

• Press SHIFT-GOTO. The 3100 displays the screen
shown in Figure 6-47.

6.15.1 Change the Normal Step
Sequence
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• To restart the current method schedule, press A. The
3100 interrupts the run and returns to the Standby
screen for the first sample and first method in the
schedule.

• To skip the rest of a run for the current sample, press B.
The 3100 interrupts its processing on the current
sample, moves to process the next scheduled sample,
and returns to the Standby screen for the next scheduled
sample.

• To rerun the current sample, press C. The 3100
interrupts the current run, goes back to the beginning of
the method to reprocess the current sample, and
displays the Standby screen for the current sample.

• To reset the microprocessor to start-up status, press and
hold the SHIFT key while you press RESET. The 3100
restarts and enters self-test  status.

• To finish the current sample and abort the rest of the
schedule, press D. The 3100 finishes the current run,
goes back to the beginning of the schedule, and displays
the Standby screen with the letter A flashing.  The
screen is shown in Figure 6-50.

At any point during the running of a method schedule, you
can skip or rerun the current sample, restart the schedule, or
completely abort it.

• From any screen, press and hold the SHIFT key while
you press RESET. The Reset screen (Figure 6-49)
appears.

6.15.2 Reset the Schedule

Figure 6-49  Reset Screen

Figure 6-50 Standby Screen after an Abort Command

<A>=Abort Schedule
 B =Abort Sample
 C =Rerun Sample
 D =Complete & Abort

Standby A M01

VlvOven 104->200C
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Figure 6-51  Schedule Status Screen

6.15.3 Review Current Status

• To cancel an attempted abort:

1. Press SHIFT-RESET on the keypad to display the
Abort Schedule screen.

2. Press D. The 3100 picks up the once-aborted
schedule at the point where it was discontinued.

The Schedule Status screen is display-only; to change any
parameters of the method schedule, press the SCHED key
to display the Scheduling screen.

· Line 1 displays the current sample position and the total
number of  samples to be run according to the current
method.

· Line 2 shows the location of the currently-active
sample. (If the 3100 is running a method, the currently-
active sample is being processed. If the 3100 is not
running a method, the currently-active sample is the one
that will be processed next.) Sample locations are:

0 .............. the single sample location on the front panel
of the 3100.

1 to 16 ..... the sample positions on an 2016/6016
Autosampler.

17 to 32 ... the sample positions on an 2032/6032
Autosampler.

· Line 3 lists the number of the method that is currently
being run, or the  method that will be run when
processing starts. Method values range from 1 to 16.

· Line 4 indicates whether or not the current method
includes parameters for autosamplers.The available
options are: 3100 - includes parameters for the 3100
front panel single sample; 60XX, 20XX, or AQUATek
50/70, and AQUATek XX - includes parameters for an
autosampler sample.

Sample # 1 of  1

Sample location:  0

Current Method:  1

Sample Type:  3100

You can review the currently-active schedule. When you
press A from the Scheduling screen, the Schedule Status
screen (Figure 6-51) appears.
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The Temperature screens are a multiple-screen listing of all
heated zones, their current temperatures, and setpoints.

To display the Temperature screens:

• Press TEMP on the keypad. Temperature Screen 1
(Figure 7-24) appears.

Figure 6-52  Temperature Screen

To display the next Temperature screen, press NEXT
PAGE.

To display the previous Temperature screen, press PREV
PAGE.

6.16 Reviewing
Temperature

CryoTrap  30C->  30C
Sample    30C->  30C
XferLine  98C-> 200C
BOT Htr   98C-> 100C
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This section describes routine maintenance procedures for
the 3100 and tells you how to:

• Prepare and load standards.

• Prepare and load samples.

• Install or change the trap.

• Clean and condition the trap.

The accuracy of your analytical results depends on the
careful storage and use of accurately-prepared analytical
standards. Purge and trap concentrator analyses are usually
run on samples with low analyte concentrations. The low-
level standards required for such analyses must be of high
quality; small errors that would be insignificant in a high
level standard contribute to a large percentage of error in a
low-level standard.

You can purchase commercially-prepared standards. A2LA-
certified solutions are produced to A2LA/EPA
specifications. To ensure that a standard is certified and that
it meets your specifications, ask the manufacturer. Suppliers
include AccuStandard, Inc. in New Haven, CT; Chem
Service Inc. in West Chester, PA; Restek in Bellefonte, PA;
Supelco in Bellefonte, PA; or Ultra Scientific in North
Kingstown, RI. If you do not wish to buy standards, you can
prepare your own.

Because the compounds usually being analyzed for are
water-insoluble and unstable in aqueous dilution, you
cannot prepare an appropriate standard by dissolving the
compounds directly in water. The steps commonly used to
prepare methanol solutions containing known amounts of
the desired compounds are listed here:

• Prepare blank (reagent, or organic-free) water.

• Prepare a standard methanol solution at the specified
concentration.

• Spike the methanol standard into a flask of blank water.

7.2 Using Standards

7.1 Overview
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7.2.2 Prepare the Methanol
Standard

7.2.1 Prepare Blank Water Blank water is water that analyzes as organic-free when run
by purge and trap analysis.  You can prepare blank water in
several ways,

• Pass water through a freshly-charged Millipore Super Q
water purifier.

• Pass distilled water through a bed of activated carbon at
least 12" deep. Put the supply vessel at a higher
elevation than the collection vessel, with the supply line
entering the column at the bottom. This configuration
allows the water to flow from the bottom to top of the
column.

• Boil water; then purge it at 80-90°C with helium or
nitrogen for at least one hour.

Note: You may use either of these preparation methods, although
the last two are the most common. No matter how you
prepare blank water, you must check its purity by analysis
before use, and you must use it immediately.

To prepare a methanol standard according to USEPA-
approved procedures, follow these steps:

1. Fill a 10 ml volumetric flask with about 9.8 ml of
methanol. Allow the flask to stand unstoppered until all
alcohol-wetted surfaces have dried.

2. Weigh the flask and its contents accurately to the
nearest 100 7g; this microgram value is W

1
.  Using a

100 ml syringe, immediately add two drops of neat
standard (minimum 75% purity) to the flask. Make sure
the drops fall directly into the methanol without
touching the neck of the flask.

4. Reweigh the flask with its contents; this microgram
value is W

2
.

5. Dilute the solution to volume (V
C 

in milliliters) with
methanol; then stopper the flask and invert it several
times to mix the solutions.

6. Calculate the concentration in micrograms per milliliter
(W

2 
- W

1
)/V

C
.

7. Transfer the solution to a 10 ml screw cap bottle with a
Teflon cap liner, and store it at 6°C.
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Methanol solutions containing 2-chloroethyl vinyl ether are
stable for one week. Other solutions prepared in this way
are stable for up to four weeks. You can vary the methanol
dilution to provide a range of standards.

7.2.3 Prepare the Aqueous
Standard

7.3 Preparing Samples

Prepare aqueous standards immediately before analysis.
When you are ready to run an aqueous standard:

• Spike a measured quantity of the methanol standard into
a 100 ml volumetric flask filled with blank water; or

• Spike a measured quantity of the methanol standard
through a microliter syringe into the luer fitting of the
sample syringe.

Note: Do not inject more than 20 ml of methanol into 100 ml of
water.

Sample size depends on many factors: the physical state
and homogeneity of the sample; the concentration and
vapor pressure of target compounds; the type of detector
used, desired detection limits, and the type of GC column.
Size has a major effect on the accuracy of the analysis
because:

• Capillary columns require small samples (or split
injection) to avoid column overloading.

• Sensitive detectors (like electron capture) require small
samples to avoid saturation.

• Less volatile compounds or compounds present in low
concentration require larger samples to be detected
accurately, although they can overload columns and
saturate detectors.

For samples of unknown concentrations, Tekmar
recommends that you start small (at 0.25 mg for solids and
0.5 ml for liquids) and increase as needed. It is usually
easier to optimize results by increasing sample size rather
than decreasing it.

7.3.1 Select a Sample Size

Before you make an analytical run, you must select an
appropriate sample size and load the selected sample.
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You can load samples in either of two ways:

• For solid samples, remove the sample glassware, insert
the sample, weigh it in the glassware, and reinstall the
glassware.

7.3.2 Load a Sample

• For aqueous samples, use a luer-lock syringe to load the
sample through the sample valve without unloading the
glassware. Follow these steps:

1. Remove the plunger from the syringe barrel.

2. Carefully pour the sample into the barrel until the
sample overflows.

3. Insert the plunger and vent any air while adjusting the
plungeR  to the desired volume.

4. Turn the arrow on the valve stem so that it points
toward the syringe. (At other times, when a sample is
not being loaded, the arrow on the valve stem should
point to the left.)

5. Insert the syringe and load the sample through the
sample valve.

The 3100 is delivered with a blank trap installed. This
prevents damage to a packed trap if the instrument was
powered up with no purge gas flow present. You must
replace the blank trap with a packed trap before you run a
sample.

Traps can be identified by a number stamped on the nut at
the top of the trap. Table 7-1 on the following pages gives
detailed information about traps and how to use them.

7.4.1 Information on Traps and
Adsorbents

7.4 Working with Traps

CAUTION

If Auto Drain is on and you use U-shaped glassware to run a
solid sample, you will damage the instrument.

CAUTION

Load only aqueous samples through the sample valve.
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   1 Tenax Everything     Yes       4-6 min.    220°C    225°C  230°C  7-10 min.    225°C Low response on
from    180 min. brominated compounds, a
methylene high back pressure, an
chloride outgassing of benzene,
and heavier toluene and ethyl

benzene

   2 Tenax Everything      No      N/A    220°C    225°C  230°C 10-12 min.    225°C Low response on
Silica Gel except    180 min. brominated compounds, a

freons high back pressure, an
outgassing of benzene,
toluene and ethyl
benzene

   3 Tenax Everything      No      N/A    220°C    225°C  230°C 10-12 min.    225°C Low response on
Silica Gel including    180 min. brominated compounds, a
Charcoal freons high back pressure, an

outgassing of benzene,
toluene and ethyl
benzene

   4 Tenax Traps      No      N/A    220°C    225°C  230°C  7-10 min.    225°C Low response on
Charcoal everything    180 min. brominated compounds, a

except high back pressure, an
gasses outgassing of benzene,

toluene and ethyl
benzene

   5 OV-1 Everything      No      N/A    220°C    225°C  230°C 10-12 min.    225°C Low response on
Tenax including    180 min. brominated compounds, a
Silica Gel freons high back pressure, an
Charcoal outgassing of benzene,

toluene and ethyl
benzene

Table 7-1  Information on Traps and Adsorbents

Trap What What it Can it Dry Purge Desorb Desorb Bake Bake Cond. Time Common Problems
   # Adsorbents Traps be Dry Time Preheat Temp. Temp. Time & Temp. for with Trap

are in it Purged? Temp. New Traps
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    6 OV-1 Everything    No       N/A    220°C    225°C 230°C 10-12 min.    225°C Low response on
Tenax except    180 min brominated compounds., a
Silica Gel freons high back pressure, an

outgassing of benzene,
toluene and ethyl
benzene

   7 OV-1 Everything   Yes    4-6 min.    220°C    225°C 230°C  7-10 min.    225°C Low response on
Tenax from    180 min. brominated compounds., a

methylene high back pressure, an
chloride outgassing of benzene,
and heavier toluene

   8 Carbopak B Everything   Yes     11 min.    245°C    240°C 260°C  4-10 min.    260°C Loss of carbon
Carbosieve including    90 min. tetrachloride. Trap may
S III freons

Carbopak C Everything  Yes    1-3 min.    245°C    250°C 260°C  10 min.    270°C High backpressure and
Carbopak B except    120 min. a low response on
Carboxen 2-chloro- chlorinated compounds
1000 ethyl
Carboxen vinyl
1001 ether

Table 7-1  Information on Traps and Adsorbents

  Supelco
  Vocarb
   4000

Trap What What it Can it Dry Purge Desorb Desorb Bake Bake Cond. Time Common Problems
   # Adsorbents Traps  be Dry Time Preheat Temp. Temp. Time & Temp. for with Trap

are in it  Purged? Temp. New Traps

need up to 11 min. of dry purge
time to remove water.
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Everything
including

freons

Everything
including

freons

Everything
down to
benzene

(It does not
trap MeOH)

Carbopak B
Carboxen

1000
Carboxen

1001

Tenax GR
Graphpac-D

Carbopak B
Carbopak C

245OC

245OC

245OC

240OC
to

250°C

250OC

250OC

Yes

Yes

Yes

260OC

260OC

260OC

4 min.

12 min.

4 min.

270OC
    120 min.

____

  270OC

Table 7-1  Information on Traps and Adsorbents

Supelco's
Vocarb
3100

Alltech
Tenax GR

   Graphpac-D

Supelco's
BTEX

Decomposition of
bromoform can occur. To
prevent this from
happening, reduce
Desorb temp. to 240°C

Unknown

Unknown

120 min.

1-3 min.

1-4 min.

1-3 min.

Trap What What it Can it Dry Purge Desorb Desorb Bake Bake Cond. Time Common Problems
   # Adsorbents Traps  be Dry Time Preheat Temp. Temp. Time & Temp. for with Trap

are in it  Purged? Temp. New Traps
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7.4.2 How to Change a Trap

To remove the trap:

1. Turn off and unplug the 3100.

2. Loosen the two screws on the 3100’s right front panel.
Slide the right-front panel forward and then to the right
to remove it.

3. Loosen the nut at the bottom of the trap one full turn,
but do not remove it completely. (It contains a two-
piece Teflon 1/8" ferrule.) If loosening it by hand is not
possible, use a 3/8" wrench to hold the bottom fitting in
place. Use another 3/8" wrench to turn the nut at the
bottom of the trap counterclockwise until the fitting is
disengaged. If the nut at the top of the trap does not
loosen easily, the ferrule may be deformed and need
replacement.

4. Use a 3/8" wrench to turn the nut at the top of the trap
clockwise (toward you) until the fitting is disengaged.
The top of the trap is designated by a 1/8" gold-plated
Valco ferrule.

5. Push the trap down and out of the top fitting; then
carefully pull the trap straight up and out of the lower
fitting and furnace assembly.

E-Clip Holding the Trap

Figure 7-1  E-clip

E-Clip

An E-clip should be installed at the bottom of the trap tokeep
the trap from sliding down. If the trap slides down, a cold
spot will be created at the top of the trap; the cold spot can
hold up heavy compounds and cause lower and inconsistent
response.

CAUTION

CAUTION

Do not use a Teflon ferrule at the top of the trap. The trap
has a one-piece gold-plated ferrule that is preswaged onto
the trap. Carryover and contamination may occur if you use
a Teflon ferrule at the top.

Make sure the trap is cool before you touch it.

WARNING
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To install a trap:

1. Slide a packed trap into the trap furnace sleeve from the
top, making sure that the one-piece gold-plated ferrule
is at the top of the trap.  When installed correctly, the
ferrule may be free to spin axially on the tubing, but
should have no lateral movement along the tubing.

2. Finger-tighten the top of the trap counterclockwise.
While tightening the top, push up on the bottom of the
trap so that it is seated all the way up in the top fitting.
To prevent gas from leaking at the fitting, use an open
end wrench to tighten the nut 1/4 turn (90°) past the
point where the ferrule first starts to grab the tubing. Do
not overtighten; too much force will damage the ferrule,
causing leaks.

If turning the nut 1/4 turn fails to eliminate a leak at the
top of the trap, look for other possible causes. Make
sure that the correct size nut and ferrule are installed
properly. (See Step 1.) Also, examine the parts for
fractures or deformities. If there are no flaws in the
parts or installation, gradually tighten the nut in
increments of 1/16 turn only. Do not risk damaging the
ferrule; if a leak problem persists, call Tekmar-
Dohrmann Service.

3. If the bottom 1/8" Teflon ferrule needs to be replaced,
remove the nut and ferrule. Slide the bottom nut on the
new trap. Then slide the two-piece Teflon ferrule onto
the trap (with the cone side down).

4. Finger-tighten the bottom trap. (While tightening, push
the trap up from the bottom fitting to make sure the trap
is completely nested in the bottom of the trap fitting.)

5. Use a 3/8" wrench to tighten the fitting 1/16 turn past
finger-tight. Do not overtighten; excess force will
damage the ferrule.

Trap lifetimes range from two weeks to five years, with the
average being approximately six months. Tenax has a
significantly shorter lifetime than silica gel or charcoal.
Silica gel and charcoal normally do not affect trap
longevity.
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You condition a trap by heating (baking) it in the 3100. The
conditioning time and temperature can vary, depending on
the type of trap you are using. To find out the correct
conditioning time and temperature for a new trap, see Table
7-1, check with the trap manufacturer or call Tekmar-
Dohrmann Service at (800) 543-4461 or (513) 247-7000.

If organic solvents are present in the ambient atmosphere,
Tekmar recommends that you condition the trap for 10
minutes at 225°C at the start of each day. This time and
temperature are usually adequate for silica gel and charcoal
traps. However, if the trap is heavily loaded or if you are
running samples containing compounds of low volatility,
you may have to bake the trap longer than 10 minutes.
Keep in mind that temperatures above 225°C do not
necessarily speed up conditioning and can damage Tenax
traps.

To condition a trap:

1. Check the Method. The Bake temperature should be the
correct temperature for conditioning the trap.

2. Press SHIFT-GO TO.

3. Press the A key (Go to Mode).

4. Press the C key (Bake).

5. Press SHIFT-HOLD to keep the 3100 in Bake mode for
the proper amount of conditioning time.

7.4.4 Conditioning a Trap

7.4.3 When to Replace a Trap Indicators of trap wear are:

• Increase in background. This usually takes the form of
benzene and other aromatics in instrument blanks.

• Losses of brominated compounds while other
compounds are constant.

• Increase in back pressure.
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7.5 Cleaning Sample

Lines
The 3100 may become seriously contaminated from a
highly concentrated sample or a poor quality gas supply.
To avoid contamination, keep the sample lines clean.

To remove sample-caused contamination:

1. Turn Bake Gas Bypass (BGB) OFF and install clean,
dry glassware.

2. Press SHIFT-GO TO. Press the A key (Go To Mode).
Press the C key (Bake). Press SHIFT-HOLD.

3. Keep the unit in Bake mode for at least 1 hour. In some
cases, longer durations might be required.

If baking does not remove contamination, you may want to
backflush the lines with the Tekmar-Dohrmann Solvent
Flush Kit (P/N 14-5118-100). Call Tekmar-Dohrmann at
(800) 874-2004 or (513) 247-7000 to order.

To remove contamination resulting from the use of poor
quality gas:

1. First replace the tank and all hydrocarbon traps on the
gas supply line.  This process may be sufficient to
obtain good blanks. If not, press SHIFT-GO TO. Press
the A key (Go To Mode). Press the C key (Bake). Press
SHIFT-HOLD.

2. Keep the 3100 in Bake mode for at least 1 hour. In
some cases, longer times might be required. If the
contamination problem persists, call Tekmar-
Dohrmann’s Service Department for assistance.
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You must clean the sample needle on a routine basis.
Frequency of cleaning depends on the kind of samples you
are running. If you are running aqueous samples, you do
not need to clean the sample needle very often. If you are
running oils and other messy samples, you must clean the
needle after every run.

To clean the sample needle:

1. Wash the needle with Alconox detergent (or equivalent)
and water.

2. Rinse well with blank water.

3. If the needle does not get clean, bake it for about two
hours at 65°C (149°F).

7.7 Cleaning the Sample
Needle

7.6 Cleaning Glassware Clean glassware is essential to interference-free runs. This
applies to flasks and cylinders as well as samplers (that is,
any vessel used to handle samples, standards, blank water,
etc.)

To clean glassware, Tekmar-Dohrmann recommends that
you use the following:

• Dedicated glassware

• Ultrasonic bath

• Muffle furnace

Dedicated glassware refers to glassware that is used for
concentrator work only. Glassware that is used for other
procedures such as extractions, often is not clean enough to
use in trace applications.

An ultrasonic bath is a time-saver. Instead of heavy
scrubbing, a brief scrubbing followed by ultrasonics is more
effective and less work.

Ultrasonic baths can clean the frits and walls of frit
samplers that brushes cannot reach. It is acceptable to use
any glassware detergents that are recommended for use in
an ultrasonic bath. (We recommend that you use the
Tekmar-Dohrmann Ultrasonic Bath.)

A muffle furnace is excellent for cleaning many samplers that
nothing else can touch. Set the temperature to approximately
350-400°C (do not go too high; the glassware may melt) and
allow the residues to be oxidized. After the glassware has
cooled, you can easily remove the remaining char with a brush
and cleaning agent. (We recommend the TekmarTM Muffle
Furnace.)
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This section describes how to use TURBOCool with the
3100. To install TURBOCool on the 3100, see the
installation instructions shipped with the TURBOCool
assembly kit. Also refer to the parts diagram at the end of
this chapter.

TURBOCool, an optional accessory to the 3100, uses liquid
CO

2
 (carbon dioxide) to permit purging onto a subambient

trap. TURBOCool can be installed into the 3100 in one of
the following ways:

• By factory personnel before the 3100 is shipped

• By a Tekmar-Dohrmann Field Service Representative

• By ordering an installation kit and doing it yourself

The 3100 with TURBOCool is built the same as the 3100
without TURBO-Cool except for:

• A special trap furnace that is inserted into a chamber
assembly

• The addition of a 12 VDC coolant valve

• The addition of a bulkhead at the rear of the 3100

The special trap furnace is inserted into an expansion
chamber assembly.

Then it is connected to the top and bottom trap fittings.

The 12 VDC coolant valve is mounted underneath the MCS
(Moisture Control System). It plugs into the connector
labeled "A" on the power supply/output card.

The bulkhead, which provides connections for tubing, is
mounted to the inlet vent on the rear of the 3100. Coolant
flows from the supply cylinder to the 3100 through the
tubing.

More detailed installation instructions are shipped with the
TURBOCool assembly kit.

8.1 Overview

8.2 Description
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Figure 8-1  TURBOCool Operation

Bottom of Trap

Line Heater

Adsorbent Trap

Trap Furnace

Escaping
CO

2
 Gas

Expansion Chamber

Adsorbent Trap

Coiled Supply Line
CO

2
 Supply

Line

Liquid CO
2 
enters the expansion chamber in the

TURBOCool accessory and spirals downward; it expands
and creates a vortex of dry ice on the outside of the trap.
(see Figure 8-1.) The vortex maintains the trap at a uniform
temperature during the purge cycle. This minimizes
breakthrough and improves resolution of the lighter, early
eluting gases in gas chromatography. It does this by rapidly
cooling the adsorbent trap to a controlled temperature
(230°C to -20°C). The trap cooldown time is less than 25
seconds.

The standard liquid CO
2
 supply cylinder will provide

approximately 45-120 runs with TURBOCool, depending
on the application. You can conserve liquid C0

2
 by allowing

the concentrator fans to cool the trap for a while after the
bake cycle. Then you can use the liquid C0

2
 to bring the

temperature down to the desired level.
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Broad, jagged, and poorly resolved peaks are a common
result of the permanent gases that are extremely volitile
(dichlorodifluoromethane, chloromethane, vinyl chloride,
bromomethane, chloroethane and trichlorofluoromethane)
and rapidly migrate through the adsorbent trap on the
concentrator. This results in minimal interaction between
the analytes and the trap sorbent, leaving a broad band of
analytes to enter the chromatographic column. Broad,
jagged, poorly resolved peaks are a common result.

TURBOCool improves chromatographic performance in
two ways:

• First, it cools the trap to a preset temperature; this
increases reproducibility because the trap stays at the
same temperature for each analysis.

• Second, at subambient temperatures, the purged
analytes stay focused in a narrow band on the trap.
When the trap is quickly heated and backflushed in the
desorption mode, the compounds stay in a tight band as
they deposit on the head of the column. This results in
better peak shape, resolution, sensitivity, and
reproducibility of the permanent gases. See the sample
chromatograms.

You can use TURBOCool in conjunction with a low volume
insert or your GC injection port to permit GC-direct
injections. TURBOCool also improves purge and trap gas
chromatography when using different column geometries.

8.3 Applications
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8.4 Specifications and

Safety
This section gives you specifications and safety information
for TURBOCool.

-20°C to 375°C. On newer furnaces, rise rate is
approximately  700°C/min.; on older furnaces, it is
approximately 200°C/min.

Uses existing TekmarTM concentrator traps (stainless steel
standard):

Length: 12"
Outer Diameter: 0.123" + or - 0.002"
Wall Thickness: 0.010"

12 VDC, liquid CO
2
 valve, 1000 psi rated

Via 3100 circuitry and software

1/8" liquid CO
2
 supply line, standard 1/8" compression

fitting

Furnace:

Traps:

Valving:

Electronic Control:

Tubing:

TURBOCool requires a SUPPLY of high pressure liquid C02 (carbon
dioxide) with inductor tube. Do not allow the SUPPLY pressure to
exceed 1000 psi.

WARNING

To avoid electrical shock, turn off and unplug the 3100 before
installing or servicing the TURBOCool accessory.

WARNING

CAUTION

TURBOCool temperatures range from extreme highs to lows. To
avoid injury, avoid touching hot or cold surfaces. Keep protective
covers in place.

Operate TURBOCool in a well ventilated area to prevent saturation
of the ambient air with carbon dioxide.

CAUTION
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Some time after the 3100 completes the Bake step, it enters
the Turbo Cooldown step. During this step, the
TURBOCool trap cools to its low temperature setpoint for
trapping analytes. The GC cycle time (GC run time plus
cooldown time) determines when the Turbo Cooldown step
begins. For example, suppose the time to complete one GC
cycle is 40 minutes and the time to complete one 3100 cycle
is 35 minutes. To coordinate the GC cycle time with its own
cycle time, the 3100 waits five minutes after the end of
Bake before advancing to Turbo Cooldown. The 3100
calculates the length of the delay (up to 1000 minutes),
based on the GC cycle time. This waiting period is called
the GC Synchronize step. This step not only provides
smooth coordinated operation, it also conserves CO

2
 by not

allowing Turbo Cooldown to start too soon.

If the GC cycle time is less than the 3100 cycle time, the
3100 will step directly into Turbo Cooldown after bake.

If you have installed a TURBOCool accessory and are
running multiple samples, the GC Synchronize step
replaces Purge Ready between runs.

Two method parameters are associated with TURBOCool:

• TURBOCool Temperature

• GC Cycle Time

The TURBOCool temperature, which is analyte-specific, is
the temperature of the TURBOCool trap. Choose a
cooldown temperature that is recommended by the USEPA
(United States Environmental Protection Agency).

Program the 3100 to cool the TURBOCool trap to a certain
temperature by:

• using a default method that includes the desired
temperature.

or

• editing your own, customized method.

8.5 TURBOCool and
Operating Cycle Times

8.6 TURBOCool Method
Parameters
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The time at which the 3100 advances to Turbo Cooldown
mode is based upon operating cycle times. (See the previous
section).

To determine GC cycle time:

1. monitor the time it takes for the GC to cool from its
bake temperature to starting temperature.

2. add this time to the GC run time.

Program the 3100 to recognize the GC cycle time by:
• using a default method that includes the desired GC

cycle time.

or

• editing your own, customized method.

The 3100:

1. determines the time needed to complete its modes of
operation.

2. subtracts this time from the GC cycle time.

3. uses this quantity to determine the time at which the
CO

2
  valve activates and Turbo Cooldown begins.

This section lists replacement parts for the TURBOCool
accessory.

To order parts, ask technical questions, or obtain service,
call one of the following numbers:

• (800) 543-4461 - toll-free in the US and Canada

• (513) 247-7000 - outside the US and Canada

Before you call for service or parts:

1. Note the model name, model number, and serial number
of the 3100.

2. If requesting assistance or service, note the type of
problem you are having: write down the conditions
under which the problem occurred and the display,
activity, or result that indicated the existence of a
problem.

3. When ordering parts, write down the part number, part
name, and quantity needed.

8.7 Ordering Parts or
Obtaining Service
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14-5763-100 TURBOCool assembly kit

14-5717-120 Trap heater, TURBOCool, 3100

14-5678-016 Elbow, 1/4" - 1/4", brass

14-5634-400 Power lead, cryo valve, 25" long

14-5582-179 Assembly, chamber, expansion

14-5467-022 Clamp, 3/4" dia.

14-4812-016 Union, reducing, 1/2" - 1/4"

14-4811-016 Flare nut, short, 1/2 OD

14-4810-002 Tubing, 1/2" OD, 2" long, copper

14-3268-046 Spacer, #6 x 1/4" long, 1/4" OD, alum

14-3105-186 Cable assembly, cryo to LN
2
 valve

14-2531-100 Valve assembly, LN2, light grey

14-1652-004 Insulation, pipe, 3/8" ID x 1/2" W

14-1313-002 Tubing, copper, 1/4" dia., raw

14-1070-004 Insulation, varglass, type H, 3/4 natural

14-0485-109 Washer, lock int. tooth, #6

12-0388-030 Heat shrink, 3/4, black

12-0325-210 Nut, hex, 6-32, SS

12-0323-C01 Screw, #6-32 x 1/2, pan head

12-0317-407 Grommet, 0.625 ID, 0.937 mount hole
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This section gives you basic troubleshooting information.

This chapter is divided into four parts:

• Calling Tekmar-Dohrmann Service

• Safety

• Troubleshooting Electomechanical Problems

• Understanding Error Screens

If you need assistance solving a problem, follow these steps:

1. Note the model name, model number, and serial number
of the instrument.

2. Note the type of problem you are having:  write down
the conditions under which the problem occurred and
the display, activity, or result that indicated the
existence of a problem.

3. Call Tekmar-Dohrmann Service at one of the following
numbers:

9.1 Overview

Before you troubleshoot, please read the safety information
in this section.

9.3 Safety

9.2 Calling Tekmar
Dohrmann Service

Unless the pneumatic lines are badly contaminated, do not flush
them with a strong solvent, such as methanol; use water
instead. The valve rotor can adsorb strong solvents and become
contaminated. If you must use a strong solvent, rinse the lines
thoroughly with water after cleaning them.

CAUTION

• (800) 874-2004 - toll-free in the US and Canada

• (513) 247-7000 - outside the US and Canada
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Do not  service a Tekmar instrument if you are not qualified to do so.
Call Tekmar-Dohrmann Service.

Disconnect power before replacing parts.

Do not redesign or modify the equipment in any way. Do not re-
move equipment grounds. Never replace a fuse with one of a higher
rating. Always use the correct replacement parts.

Assume that high current and voltage are on  ALL circuits.

Do not place liquids near the area where you are troubleshooting;
liquids can spill on live circuits and conduct electricity.

Jewelry conducts electricity; remove jewelry.

Use insulated tools.

Capacitors on electronic circuit boards can hold an electrical charge
even after you turn off the unit. Do not touch the capacitors.

Do not troubleshoot when you are tired or taking medication that
makes you drowsy.

Work in a well-lighted area.

Do not work alone.

Wear safety glasses.

Follow the manufacturer's directions when using solvent and other
chemicals. They may ignite, explode or damage the equipment.
Also refer to MSDS (Material Safety Data Sheets) for safety
information.

Place a fire extinguisher nearby that is rated for electrical and
chemical fires.

Internal parts (especially heaters, heat sinks and some electronic
components) can get very hot. When troubleshooting, be careful not
to touch these parts. Allow parts to cool before replacing them.

Some Tekmar accessories require the use of liquid CO2 (carbon
dioxide) or LN2 (liquid nitrogen). These chemicals produce low
temperatures that can damage human tissue. Avoid  touching the
chemicals or the surfaces that they cool.

Do not exceed maximum pressure ratings for Tekmar instruments.

DANGER
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No Power to the 3100

* Make sure that the 3100 is off and unplugged.  Insert the end of a small, slotted screwdriver into the
notch on the power module. With the screwdriver, gently pry the fuse holder out of the power
module.

Yes No

Is the power cord attached
to the 3100 and plugged

into the power receptacle?

Is the voltage correct for the
system's power requirements?

Call Tekmar-
Dohrmann

Service

Flip power
switch to ON

Turn off and unplug the 3100.
Check the fuses in the power module
on the rear of the 3100*.  (The on/off
switch is part of the power module.)

Are the fuses good?

Replace the fuse.  Use
correct rating and type.

Has the circuit
breaker tripped?

Try a different power
receptacle.  Do not use an

extension cord!

Reset the
breaker.

YesNo

Plug in the
cord

Is the power switch in the ON
position?  (Check wall switch

also, if applicable.)

No

No

No

Yes

Yes

Yes
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* To check for leaks, see the leak problems flow chart in this section.

No Purge Flow Out of the Vent

Yes, Bubbles No, Bubbles

YesNo Is there sparging through the
sparge tube?

Is the purge gas
supply on?

Do bubbles stop within
0 to 7 min. without
capping the vent?

Is there flow out of
the sample valve?

Set to 20 psi.

Check all fittings before the
sparger for leaks or blockage.
Use a flow meter to check for

flow.  if there is no flow, check for
either a blockage or a leak.*

Call Tekmar-
Dohrmann
Service.

Is the flow
controller open? Turn on gas

Is there 20psi on
the gauge?

Set flow controller
to 40 ml/min.

Yes

Yes

Yes

Yes

No

No

No

No

Check for leaks.
(See leak problems

flow chart in this
section.)

Disconnect the top of trap and
other points to see if bubbles start.

Blockage is likely
between the

sample mount and
the top of trap

fitting.

Blockage is likely
between the vent

and top of trap
fitting.
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Leak Problems
CAUTION:

Do not tighten nuts
more than finger-

tight, plus 1/4 turn.
Too much force
damages the

ferrules.

Put 5ml of water in sparger.  Cap vent.  Step to purge and hold.
Turn off heaters and disconnect fans

Bubbling Stops Bubbling does not stop

Before During

Did it stop bubbling
within 3 to 14 minutes?

Check all ferrules in the instrument.
•  at bottom of trap
•  at top of needle
•  at top of glassware

Does it purge
initially?

Finished

Cap off at the
bottom of the

trap fitting.

FinishedCheck all fittings
before the glassware.

Refer to the diagram in
the manual.

Check for
cracked
ferrules.

Go to the flow chart titled,
No Purge Flow Out of the

Vent in this section.

If the leak is before the trap,
check all fittings between the

trap and the glassware.
Retest

Still the
same?

Go to step IIIGo to step II

If the leak is after the
trap, check the trap

fitting and vent.

Check Teflon
ferrule for
abnormal

shape.

Cap the N/C
position on
the HRP

valve.

Finished
Finished

Check all
ferrules for

cracks.

Replace
ferrule.

Go to
step I.

Finished

Call Tekmar-
Dohrmann
Service.

Replace
ferrules.

Call Tekmar-
Dohrmann
Service.

Finished

Replace all
bad

ferrules.

Call Tekmar-
Dohrmann
Service.

Call Tekmar-
Dohrmann
Service.

Finished

Call Tekmar-
Dohrmann
Service.

Finished

Check ferrules on
fittings after trap.

Finished

I

II

III

Yes No Still Stopped

Still Stopped

Still Stopped
Still Stopped

Normal Abnormal

Good Cracked

StoppedStill

Still Stopped

Bad

Still Stopped

Still Stopped

Good
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Reduced Sensitivity

Bubbles

Do several
direct injections
on GC column

Bad chromatograms

Good
chromatograms

Bubbles No Bubbles Early Late

Troubleshoot GC.
Use GC manual.

Fill sparge
vessel with
water.  Cap

off vent. Check chromatograms
for problems with early

or late eluters

Breakthrough -
reduce purge

time.

Change trap.

Change trap.

Finished

Finished

Finished

Call
Tekmar-

Dohrmann
ServiceAre the

compounds
brominated?

Check
glassware
fitting

Run
unit.  If
still bad,

go to
Step II

Check
connection

between
the 3100
and GC.

Active sites - Call
Tekmar-Dohrmann

Service

Call Tekmar-
Dohrmann

Service

No BubblesBubbles

Run unit.
If still bad,
go to Step

II.

Check other
fittings in

unit.

No Bubbles

Good Bad

Bad Good

Yes No

Bad Good

I II
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Lack of Response

Direct injection
on GC.

Troubleshoot the GC.
Refer to GC manual.

• Check the purge gas supply
• Check the purge flow at vent
• Make sure there is a number on the trap
• Make sure the cable that extends from the

concentrator to the GC is the right one and is
correctly installed.

Inject on top of trap.

Purge system.Desorb system.

Place H
2
O in vessel.

Look for bubbles.
Is the trap
heating?

Leak before
sparge vessel.

Leak after
sparge vessel.

Check flow at
bottom of trap
fitting during

Desorb mode and
call Tekmar-

Dohrmann Service

Call Tekmar-
Dohrmann

Service

Bad
chromatograms

Good
chromatograms

If good

ResponseNo Response

Yes No

Bubbles No Bubbles
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Carryover Contamination

Did you run a high level sample?

If still bad, go to Step II

Reconnect trap and bake

Set it to 100°C

Purge 10-20 minutes

Remove H
2
O

Purge 30 minutes

With H
2
O bath, heat sparger to

100°C.  Go to Step I

Do you have a sample heater?

Call Tekmar-
Dohrmann Service

Put 3100 in Bake mode for 30
minutes with trap disconnected and

temperatures elevated

Flush 75 ml  of H2O -
collect in sparger

Flush with 25 ml of a
solvent (methanol)

Connect a syringe with an adapter to
the trap (14-5118-100)

Steam clean... Finished

Leave valve and line temps up

Disconnect the top of the trap
or install a #6 trap.  Caution!

Trap may be hot!

You have vapor phase adsorption You have liquid phase deposition

See caution on page 1 of this section.
Clean with solvent (methanol)...

Turn heaters down to < 50°C.

Backflush

Remove trap and purge line to
sparger.  Caution!  Trap may be hot!

Yes No

Put 3100 in Bake mode for about an hour

Bad Good

Finished

Put 5-10 mls of blank
H

2
O in sparger

II

I

Yes
No

Bad Good
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       Service and Parts 10
To order parts, ask technical questions, or obtain service,
call one of the following numbers:

• (800) 543-4461 - toll-free in the US and Canada

• (513) 247-7000 - outside the US and Canada

10.1 Calling Sales or
Service

Before you call for service or parts:

• Note the model name, model number, and serial number
of the instrument.

• If requesting assistance or service, note the type of
problem you are having: write down the conditions
under which the problem occurred and the display,
activity, or result that indicated the existence of a
problem.

• When ordering parts, write down the part number, part
name, and quantity needed.

This section lists part numbers and names for 3100
replacement parts. which are listed by type.

10.2 3100 Parts List
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14-2337-024 5ml Frit Sparger (glassware only)

14-2334-024 25ml Frit Sparger (glassware only)

14-2336-024 5ml Fritless Sparger (glassware only)

14-2333-024 25ml Fritless Sparger (glassware only)

14-2052-024 5ml Needle Sparger (glassware only)

14-2053-024 25ml Needle Sparger (glassware only)

14-3096-100 5ml Frit Sparger Kit

14-3095-100 25ml Frit Sparger Kit

14-3094-100 5ml Fritless Sparger Kit

14-3093-100 25ml Fritless Sparger Kit

14-3599-100 5ml Needle Sparger Kit

14-3600-100 25ml Needle Sparger Kit

14-4817-024 5ml Fritless Sparger, right intro stem for use
with 2050 or AQUATek 50

14-4818-024 25ml Fritless Sparger, right intro stem for
use with 2050 or AQUATek 50

14-3544-024 5ml Frit Sparger, w/left introduction stem
for 2050 or AQUATek 50

14-3546-024 25ml Frit Sparger, w/left introduction stem
for 2050 or AQUATek 50

14-3544-124 5ml Frit Sparger, w/right introduction stem
for 2050 or AQUATek 50

14-3546-124 25ml Frit Sparger, w/right introduction stem
for 2050 or AQUATek 50

10.2.1 Glassware
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14-5684-000 Sample Valve, 3-Port Assembly

14-0216-016 Female Luer Connector for Sample Valve

14-5682-202 Drain Line Assembly

14-5681-102 Purge Line Assembly

14-0036-050 Sample Valve, 3-Port

14-3196-053 Sample Needle, 25ml 9 1/8", for 25ml frit
sparger, 25ml fritless sparger

14-3595-053 Needle, 7.75" for 5ml frit sparger, 5ml
fritless sparger

14-5186-053 Needle, pointed, 7.75" 16GA, .009" wall, for
5ml needle sparger

14-5186-453 Needle, pointed, 10.25" 16GA, .009" wall,
for 25ml needle sparger

14-0122-016 Male Luer Fitting for Syringe Valve

14-0069-052 5ml Sample Syringe w/Luer Connector

14-0070-052 25ml Sample Syringe w/Luer Connector

10-0089-052 10 ml Calibration Syringe

14-0114-050 Syringe Valve, 2-port with Luer Connector

14-4045-403 GLT Trap 6G

14-4046-403 GLT Trap 7G

14-4047-403 GLT Trap 8G

14-4939-403 GLT Trap 9G

14-0539-002 Tubing, Fused Silica 0.32 mm ID

14-2072-002 Tubing, Fused Silica 0.53 mm ID

14-5229-002 Tubing, 1/16", Nickel, Large Bore Purge and
carrier gas to BOT pathways

14-5540-002 Tubing, ElectroForm .04 I.D. .06 O.D. (used
in sample pathway)

14-5543-002 Tubing, Electroform .02 I.D., transfer line

14-5283-102 Tubing, ElectroForm 1/16 Set (2 pieces -
purge lines)

10.2.4 Traps

10.2.3 Syringes

10.2.2 Sample Handling

10.2.5 Tubing
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14-5773-016 Ferrule, 1/8", Valco, gold

14-5495-016 Union, 1/4" to 1/16"

10-0064-016 Union, 1/8" to 1/8" stub, brass, bulkhead

14-0241-016 Ferrule, 1/16", SS, single piece Valco

14-0051-016 Union, 1/16", brass

10-0073-016 Union, 1/8", brass

14-3404-016 Union, 1/16" SS, Swagelok, without ferrules

14-4824-116 Union, reducing, 3/4" x 1/2"

14-0050-016 Union, 1/8" to 1/16", SS

14-0264-016 Union, bulkhead 1/16" SS

14-0356-016 Union, bulkhead 1/8" filter assembly

14-5685-016 Union, 1/16" Brass

14-4695-016 Union, tee, 1/16" Brass

14-0241-016 Ferrule, 1/16", SS, single-piece Valco

14-0158-016 Ferrule, 1/16", SS, Swagelok

14-5663-016 Ferrule, 1/16", Teflon

14-1301-016 Ferrule, 1/2", Teflon

10-0041-016 Ferrule, 1/4" Teflon

14-1301-016 Ferrule, 1/2", Teflon

14-0521-016 Ferrule, 0.4 mm I.D. graphite/vespel

14-0540-016 Ferrule, 0.5 mm I.D. graphite/vespel

14-2074-016 Ferrule, 0.8 mm I.D. graphite/vespel

14-2931-016 Ferrule, 1/16" I.D. graphite/vespel

10-0408-016 Ferrule, set 1/8" SS

10.2.6 Fittings

14-5228-002 Tubing, 1/16" Nickel, Small Bore
Line between HRP valve and brass tee

14-3845-002 Tubing, 1/16" Nickel, Large Bore Flexible

14-3125-002 Tubing, Hypodermic SS, 16 GA

14-0583-002 Tubing, 1/8", Teflon, FEP

14-6104-002 Tubing, Silcosteel, Non-Polar, 1/16OD,
.04ID

14-6085-002 Tubing, Silcosteel, 1/16OD, .02ID
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10.2.7 Heaters

10-0043-016 Ferrule, Teflon, 1/8" set

14-2931-016 Ferrule, 1/16", graphite/vespel

14-3123-016 Ferrule, 1/16", Upchurch ETFE

10-0405-016 Nut, for 1/8" fitting SS

14-4602-016 Nut, 1/8", SS, Valco

14-3124-016 Nut, short blk, 1/16" Upchurch

14-0159-016 Nut, 1/16", SS, Swagelok

14-0243-016 Nut, 1/16" short

14-3295-016 Nut, 1/16", SS male, Swagelok

14-2792-016 Nut, cap, 1/16" brass

10-0076-016 Nut, plug, 1/8" brass

14-6216-016 Tee, 60 degree side port

14-5302-016 Elbow, 1/8" - 1/16" bulkhead SS

10-0042-016 Reducer, 1/16"-1/8" tube stub

14-5686-016 Bulkhead, 1/8" - 1/16" SS, with filter

10-0338-016 Bulkhead, 1/8"  SS, with filter

14-7037-016 Fitting, Flangeless Nut, 1/8"

14-7038-016 Bushing, Exit, 1/8" TEFZEL, short

14-6216-316 Tee, Silcosteel, 3100

14-5302-116 Bulkhead, 1/8" - 1/16", Silcosteel coated

14-5736-000 Kit, pocket sample heater

14-5736-100 Kit, tube heater

14-5717-220 Heater assembly, trap

14-5718-020 Heater assembly, bottom of trap

14-5307-020 Heater, transfer line 72"

14-5687-020 Heater, cartridge assembly (oven)

14-5691-079 Plate, machined, valve oven

14-5555-026 Thermocouple, type K 16" (oven)

14-5654-120 Heater assembly, MCS, with heat sink

14-6108-120 Mount, Heated Sample, Silcosteel, 3100

14-5717-220 Trap Heater, 115VAC, for 1/8" x 12" lg. trap
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14-5298-050 Valve, 6-port, 350°C

14-5298-150 Actuator, 6-port valve, 3100 spare

14-5529-050 Valve, assembly, sample 12 VDC

14-5527-050 Valve, assembly, bypass 12 VDC

14-5530-050 Valve, assembly, vent 12 VDC

14-5716-050 Valve, assembly, HRP 12 VDC

14-5526-150 Assembly, Drain Valve, 1/8" Line, 12 VDC

14-5675-150 Pressure Regulator, 1/16" fitting with guage6

14-4570-000 Pressure Gauge assembly, 0-30 PSI

14-5522-050 Flow Controller, 0-100 cc/min

14-5285-267 Loop, MCS, 600-650µl, Silcosteel coated

14-1362-000 Hydrocarbon Trap Assembly

14-5092-000 Installation Kit

14-5778-050 Valve, Needle (TPC) 1/16" tubes

14-5330-090 PC Board Assembly, Cryofocusing Module
Logic

14-1719-050 PC Board Assembly, Actuator

14-5233-090 PC Board assembly, Microcontroller

14-5393-390 PC Board assembly, Memory 3100

14-5235-090 PC Board assembly, Comm/Interface

14-5749-090 PC Board assembly, Output

14-5310-090 PC Board assembly, Interconnect

14-5315-090 PC Board assembly, Thermocouple

14-5329-090 PC Board assembly, Autosampler Card

14-7434-090 PCB Assembly, LED, 3100

14-5297-191 Display assembly, LED with connector

14-5439-080 Cover, Display Clear

14-5528-086 Modular Jack with Cable

14-3027-000 Cable, 6-port Valve

14-5558-086 Cable, 6 pin Modular, Coiled

14-5321-080 Expansion Slot Cover (thermocouple)

14-0298-039 Power Cord, 110V

10.2.8 Valves and Pneumatics

10.2.9 Electronics
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14-5291-038 Transformer assembly, 110V - 24V/8V

14-5177-238 Transformer assembly, 100V -110V

14-5634-600 Wiring kit, main, 110V

14-4383-028 Switch, power, 10 amp filtered

14-5634-700 Power lead, trap 25"

14-5634-100 TC Extension, trap 25"

14-5634-200 TC Extension, BOT 13"

14-5634-300 TC Extension, MCS 8 1/2"

14-5634-500 Cable display, 21"

14-5180-034 Fuse, 10A, 250V 5 x 20 mm

14-4961-034 Fuse, 4 amp 5 x 20 mm

14-5757-034 Fuse, 4 amp, sub-min, fast for output module

14-4738-028 Switch, interlock, 125 VAC (trap)

14-5740-058 Output module

14-4952-000 Low Volume Insert, HP 5890 Packed
Injector

14-4952-100 Low Volume Insert, HP 5890 Purged Packed
Injector

14-5506-000 Low Volume Insert, HP 5890 Split/Splitless
Injector

14-4633-000 Low Volume Insert, Varian (except Varian
1075 Capillary Injector - available soon)

14-4634-000 Low Volume Insert, Perkin Elmer 8000
Series, Sigma 2000 and 2100 GCs (will not
work on Autosystems,Sigma Ib-4b and 300
Series GCs)

14-4635-000 Low Volume Insert, Tracor 540, 585

14-4635-100 Low Volume Insert, Tracor 560, 565, 570

14-4635-200 Low Volume Insert, Tremetrics 9000

10.2.10 Low Volume Inserts



10 -8  Tekmar 3100 Purge and Trap Concentrator User Manual

Service and Parts10
10.2.11 Septum Needle Adapters* 14-4913-153 Septum Needle Adapter Kit, Varian 1040/

1041 Packed Injection Port

14-4913-253 Septum Needle Adapter Kit, Hewlett
Packard 5890A Capillary Injection Port

14-4913-353 Septum Needle Adapter Kit, Hewlett
Packard 5880A and 5890A Packed Injection
Port.

14-4913-453 Septum Needle Adapter Kit, Varian SPI
1075/1077 and Tracor 540 Injection Ports

14-4913-553 Septum Needle Adapter Kit, PE Sigma 2000
Series

14-5009-043 Septum Replacement for Septum Needle
Adapter-Pack of 5 Septa

10.2.12 Septum Nuts 14-1591-110 Septum Nut, Varian 1040/1041 Injection
Port.

14-5036-010 Septum Nut, Hewlett Packard 5890A
Capillary Injection Port.

14-5036-110 Septum Nut, Hewlett Packard 5890A Packed
Injection Port.

14-1591-410 Septum Nut, Varian SPI 1075/1077 and
Tracor 540 Injection Ports

14-1591-510 Septum Nut, Perkin Elmer, all Sigma Series,
all 800 Series and Autosystem Injection
Ports.
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14-2991-000 Interface, Hewlett-Packard 5890 GC

14-4188-086 Interface, Hewlett-Packard 5890 w/5970
MSD and Unix or Pascal-based software1

14-4652-086 Interface, Hewlett Packard 5890 w/5970
MSD and Unix-B or MS-DOS software, HP
5890/5971/5972 MSD and  Unix-B or MS-
DOS software, and HP 5890/5989 MS
Engine

14-2993-000 Interface, Hewlett-Packard 5995/96/85/87/
88/92 GC/MS with HP-1000/RTE GC/MS
Software, HP 5890 w/5970MSD and RTE
(RTE-A, RTE-6, or Rev F2)

14-2974-000 Interface, Hewlett-Packard 5700 Series (exc.
5710/30/90)

14-2976-000 Interface, Hewlett-Packard 5710/30/90 GC
w/5970 MSD with Chemstation using
Quicksilver Software

14-2990-000 Interface, Hewlett-Packard 5880A/5840A

14-3318-000 Interface, Hewlett-Packard 5995/96/87/85/
92

w/Chemstation-Quicksilver

14-3010-000 Interface Kit, Hewlett-Packard 5995/85/
9392 GC/MS (includes I/O box). requires
HP’s BATCH or AQUARIUS Software and
external events relay board to operate with
SIDS Data System

14-6689-086 Interface, Hewlett-Packard 6890 Series GC

14-2968-000 Interface, Varian 3300/3400/3500/3600 with
or without serial I/O

14-2969-000 Interface, Varian 3700

14-3052-000 Interface, A & B to Varian Vista I/O Box

14-2972-000 Interface, Tracor 560/565/670

14-2992-000 Interface, Tracor 540 and Waters Dimension
I

14-3430-000 Interface, Tracor 585/9000 and Waters
Dimension II

14-2970-000 Interface, Perkin-Elmer Sigma Series

10.2.13 Interface Cables
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10.2.14 Miscellaneous

14-3233-000 Interface, Perkin-Elmer 8000 Series/
Autosystem

14-2973-000 Interface, Shimadzu GC9A

14-4610-086 Interface, Shimadzu GC 14A/15A, GC 14A
w/QP 1000 EX MSD and GC 14A w/QP
2000 MSD

14-4009-000 Interface Splicer Cable, Finnigan 5100/4000/
4500 and OWA

14-4938-086 Interface, Carlo Erba Mega/Vega Series and
Fisons 8000

14-3147-000 Interface, General Purpose/HNU 301/321/
4213

3 Valve driver option necessary from HNU.

14-5118-100 Kit, Solvent Flush

14-5959-000 Kit, Desorb, 1/4" x 7"

14-5525-019 Blower assembly, 60 CFM 115V

14-5524-219 Fan assembly, 3 1/8" SQ, 14" Leads

14-5524-319 Fan assembly, 3 1/8" SQ, 11" Leads

14-6000-217 Carton, Shipping, with Foam

14-3100-074 Manual, User, 3100

14-5765-176 TekLink, 3100

14-5306-185 Panel, Front, 3100
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AEROTrap 6016/6032  2-9
All A/C Outputs  5-12
ALS 2016/2032  2-9
Ambient  5-12, 6-19
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Control

Buttons  5-25
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Desorb  2-8, 4-3, 4-10, 4-12, 6-33

Preheat  4-11, 6-32
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Preheat Temp  5-16
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Pneumatic Connections  3-1
position  5-23
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Power Requirements  2-2
Preheat  4-9
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Sample  2-8
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Drain  5-16
Fill  4-9
Flow  3-8

Sample Gas  2-8
Flow  2-8, 3-8
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line  3-2
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assembly  2-5
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Sample Method Does Not Match Schedule Position  5-
29
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Temp  5-16
Time  5-16

Sample Pressure  3-7
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Editing Screen  6-29
sample sparger  2-8

assembly  2-5
Sample Status  6-8
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assembly  2-5
sample vial  5-23
Save
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Schedule Button  5-21

SCHED  6-2, 6-4, 6-8
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Help Button  5-21
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Select
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Parameters  6-24
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Failure on Heater X  5-29
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sequence of methods  5-22
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Setting
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SETUP  6-2, 6-4, 6-8
Setup Screen  6-13
SHIFT  6-2
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software  2-9
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Specify
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System Reset  5-29
System Reset Screen  6-13
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TEK3100  5-2
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installation  5-1
software  2-9

Tekmar Identification Screen  6-11
Temp Zone Status  5-24
Temperature

Parameter Display  6-6
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setpoint  4-7, 6-8
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Zone Status  5-24

temperature-dependent steps  6-8
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Time and Temperature Parameters  4-7
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Trap lifetime  7-9
Trap Pressure Control (TPC)  2-8, 3-7

valve  2-8, 4-7
effects  5-13

Trap Pressure gauge  2-5
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active-low signals  6-16

Tubing  10-3
Turbo Cool Temp  5-16
TURBO Cooldown  4-9, 8-6
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Applications  8-3
Method Parameters  8-5
Operation  8-2
Operating Cycle Times  8-5
Specifications and Safety  8-4
Temperature  8-5
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ultra-high purity helium  2-8
Ultrasonic bath  7-12
Understanding Operating Steps  4-8
union  3-4, 3-6
Unit Type  6-14
Unpacking  2-1
Update Schedule  6-9
User  6-16
User GC Type  5-13
Using GC Regulated Carrier Gas  3-3

Using Methods  5-14
Using Screens  6-6
Using Standards  7-1
Using the Editing Screens  6-23

V

valves  2-8
configurations  4-4, 4-11
Settings  4-4
Temp  5-16

Valves and Pneumatics  10-6
Variable Function Keys  6-2

options  6-8
Vent Valve  4-5
vial positions  5-21
volatile

analytes  2-8
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When to Replace a Trap  7-10
Working with Traps  7-4
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